
101
www.3DArtistonline.com

Practical inspiration for the 3D community

FREE 8GB OF VIDEOS & MORE

BLENDER
PROJECTS

MASTER 6 ASTONISHING 

METICULOUS
MODELLING
Get the best out of the Hard Ops plugin for 
Blender and build a stunning sci-fi asset

Utilise After Effects and Element 3D to integrate a fully CG 
model into a live action scene – on budget and on time

PRO VFX TRICKS
Sculpt and texture a realistic insect and bring it into Unreal 

Engine for fast iterations and fascinating lighting experiments

RENDERINGTIPS

EXCITING 2.78 TOOLS EXPLORED

MASTER HARD SURFACES

THE BEST PLUGINS AROUND

REAL-TIME
REVOLUTION
We deconstruct six of the major game 
engines and put them to the test

BUILD 
SHADERS
IN MAYA

PAGE 68

ISSUE 101

Digital Edition
GreatDigitalMags.com





33

Jüri Unt
www.cgstrive.com

Software Blender

Enhance 
your Blender 

projects   
Page 22



Have you recovered from issue 

100 yet? You’ll be pleased to 

know that as soon as it fl ew off  to 

the printers, we were straight back 

on the horse to put together an 

equally amazing issue 101 for you 

this month.

For starters, we’ve got two very 

special treats in store for fans of 

Blender – six essential projects for you to try today, and 

a superb Hard Ops masterclass to show you just how 

incredible your hard-surface modelling can be in the 

free program when you have the know-how.

Recently, we’ve been speaking to loads of artists, 

friends and partners from around the world about 

game engines and their virtues, not just in the games 

industry, but also in the fi elds of VR and design 

visualisation. More and more of you are starting to 

experiment with these real-time tools, especially as 

they’re more accessible than ever before, so we’ve 

deconstructed fi ve popular engines and thrown a 

couple of handy workfl ows in there to get you up and 

running in no time.

We’ve also been super-lucky to catch up with some 

of the brilliant artists working for VFX Legion, who have 

been responsible for some really ambitious shows in 

recent years. It operates like no other facility, so be sure 

to check out what the team has to say! Enjoy. 

Steve Holmes, Editor

Get to grips with Hard Ops 
in Blender Page 60
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Meet YellowDog, a winning combination of superfast rendering and right first time cer tainty.
How do we do it?

 I T ’ S  F A S T  because we give you access to massive amounts of crowd and cloud sourced processing power.

 I T ’ S  F A I T H F U L , with built in checks to make sure that every frame is delivered back to you error free.

 I T ’ S  H O N E S T .  Our quotes are accurate, and you only get charged what’s quoted.

 I T ’ S  F R I E N D L Y and easy to use, every ar tist’s dream.

 I T ’ S  O B E D I E N T – whether you want it faster or cheaper, it delivers.

I T ’ S  F L E X I B L E so you can take on the largest jobs with no capital outlay.

YellowDog is your best friend in rendering. Sign up at www.yellowdog.co
or call us on +44 (0)330 223 2499 to find out more.

YELLOWDOG.
IN THE ART OF RENDERING

IT’S THE BEST OF BREED. 

FAST. SPOT ON.

G O  F U R T H E R  A N D  F A S T E R  W I T H  Y E L L O W D O G



is issue’s team of pro artists…

JÜRI UNT
cgstrive.com

If you’re a Blender fan you’ll recognise this

month’s cover image straight away. It’s so

good, the Blender team has splashed it all

over its site! Head to our Blender 

masterclass on p22 to fi nd out more.

3DArtist username cgstrive

MICHAEL CAUCHI
mikecauchiart.com

Michael came to us a while ago with the 

idea for a procedural shaders tutorial in 

Maya and V-Ray, and we gladly obliged. 

Head over to p68 to check out his 

workfl ow and build your own shaders.

3DArtist username mikecauchi

MATTHIAS DEVELTERE
develterematthias.wordpress.com

MODO is a really powerful and effi  cient 

modelling tool, as demonstrated by 

MachineGames’ Matthias on p72. He’s 

here to teach you how to speed-model 

your own game-ready assets. 

3DArtist username DevMatt

MIKE D MCCALLUM
reallusion.com

You can’t go anywhere at the moment 

without everyone talking about VR, 

especially now consumer headsets are 

hitting the market. Mike walks you 

through a VR workfl ow in iClone on p76. 

3DArtist username n/a

JERRY PERKINS
masterxeon1001.com

Jerry heads up the development of Hard 

Ops, a fantastic hard-surface modelling 

plugin for Blender. Join him on p60 as he 

takes you through key features and builds 

a stunning sci-fi  asset. 

3DArtist username masterxeon1001

ERIC KELLER
bloopatone.com

Not content with studying and perfectly 

replicating insect specimens that he’s 

ordered online, resident entomologist Eric

has decided to start experimenting with 

Unreal Engine. Check it out on p46.

3DArtist username bloopatone

GUSTAVO ÅHLÉN
facebook.com/gustavoahlenstudio

Compositing CG into live-action footage 

is one of the cornerstones of visual 

eff ects. On p54, the ever-versatile 

Gustavo turns his hand to shot integration 

in After Eff ects and Element 3D. 

3DArtist username gustavoahlen

AMARU ZEAS
amaruzeas3d.com

AMD’s new renderer, Radeon ProRender, 

now has support for Maya, so we’ve 

asked Amaru to take it for a spin over on 

p80 and show off  some lighting and 

materials basics in the new tool. 

3DArtist username amaruzeas

PAUL CHAMPION
linkedin.com/in/pchampion

We’ve been monitoring the real-time 

revolution that’s happening at the 

moment, so thought it would be a solid 

idea to get Paul to deconstruct some 

game engines for your pleasure on p38.

3DArtist username Rocker
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Bring your world to life.
Procedurally.

SideFX.com

Artwork: Anastasia Opara



Save up to 50%
SUBSCRIBE TODAY

Turn to
page 84
for detai
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What’s in the magazine and w

54

Assembling a 
VFX Legion

Integrate CG into 
live-action footage

 You can 
refi ne the sculpt 
using Pinching 
and Creases to 
mark some
sharp edges  
Pierrick Picaut on how he 
makes the most of Blender's 
features Page 30
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 News, reviews 
& features
 12  The Gallery

A hand-picked collection of incredible 
artwork to inspire you

 22   Master 6 Astonishing 
Blender Projects
Whether you’re new to Blender or raring 
to get started with something diff erent, 
we’ve got six projects for you to try today

 32  Assembling a VFX Legion
What does it take to create a successful 
remote working visual eff ects facility? The 
industry veterans at VFX Legion divulge all

 38  Game Engines Deconstructed
From Unreal to CryEngine, get to know the 
ins and outs of the engines powering the 
best games today 

 82  Technique Focus: NTO 001.07
Teun van der Zaim explains how smoke 
and particle eff ects formed his 
spectacular space simulation

 84  Subscribe Today!
Save money and never miss an issue by 
snapping up a subscription

 86  Review: WS-X1100S
Orestis Bastounis puts the small but 
powerful Workstation Specialists system 
through its paces

 88  Review: Anima 2
We take a look at the rewritten crowd 
production tool to see what version 2 
brings to the table

 98  Technique Focus: September 9, 2109
Paul Pepera tells us how he used a simple 
lighting setup to evoke a dramatic mood

 Review: 
WS-X1100S



ThePipeline
46 Stepby step:Createa realistic

tigerbeetle for real-time
rendering inUnreal
Eric Keller teaches you how to
render an insect in a game engine
and paint metallic textures

54 Stepby step: IntegrateCG into
live-action footage
Merge 3D geometry with footage
and integrate foreground objects

60 Pipeline techniques:Master
HardOps for Blender
Jerry Perkins shows you how to
build hard-surface concepts

68 Pipeline techniques:Beginner’s
guide to procedural shaders
Create basic materials for easy
repurposing, iterations and tests

72 Pipeline techniques:Speed
model a gameasset inMODO
Matthias Develtere reveals how to
create triple-A assets quickly

76 Pipeline techniques:CreateVR
contentwith iClone andUnity
Generate characters, environments
and assets for virtual reality

TheHub
90 Community news

Get the lowdown on Oculus and
friends sculpting live on Facebook,
plus we round up BFX Festival 2016

92 Industry news
Almost $2 million in grants has
been dished out by Epic Games and
Allegorithmic has a busy month of
new releases and launches

94 Project Focus:Beat Bugs
Rachit Singh tells us how Atomic
Cartoons and cloud rendering came
together for the Beatles cartoon

96 Readers’ gallery
The very best images of the month
from our online community
www.3dartistonline.com

Create a realistic tiger beetle for
real-time rendering in Unreal

MartinTeichmann reveals
his process for content

creation in Unreal Page40

 UE4 provides a
broad range of

eff ects that I can rely
on to help me to

achieve my vision

Visit the3DArtistonline shop at

for back issues, books and merchandise

72

38

46

60
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 Speed model a game 
asset in MODO

Master Hard 
Ops for Blender

68

Beginner’s guide to 
procedural shaders



Free with 
your magazine

Register to get instant access
to this pack of must-have 
creative resources, how-to 
videos and tutorial assets

Blender videos
from Pluralsight
Learn to create stunning
environment art

Premium CGAxis
tree models
Three brand-new images
to use in your work

25 textures from
3DTotal.com
Download plenty of
high-quality textures our real-time insect rendering tutorial

CG shot integration guide

Hard Ops tutorial

help you follow our vast array of
additional expert tutorials

Plus, all of this
is yours too…

Log in to www.filesilo.co.uk/3DArtist Free 
for digital 

readers too!
Read on your tablet, 
download on your 

computer



Get started
Everything you need to 
know about accessing 
your FileSilo account

01Follow the instructions 
on screen to create an 

account with our secure FileSilo 
system. Log in and unlock the 
issue by answering a simple 
question about the magazine.

02You can access FileSilo 
on any computer, tablet 

or smartphone device using any 
popular browser. However, we 
recommend that you use a 
computer to download content, 
as you may not be able to 
download files to other devices.

03 If you have any 
problems with 

accessing content on FileSilo 
take a look at the FAQs online 
or email our team at the 
address below
filesilohelp@imagine-publishing.co.uk

Unlock the entire 3D Artist FileSilo library with your unique Web
ID – the eight-digit alphanumeric code that is printed above
your address details on the mailing label of your subscription
copies. It can also be found on any renewal letters.

Already a print subscriber?
Here’s how to unlock FileSilo today…

The home of great
downloads – exclusive to 
your favourite magazines 
from Future!

Secure and safe online 
access, from anywhere

Free access for every 
reader, print and digital

Download only the files 
you want, when you want

All your gifts, from all 
your issues, in one place

Over 50 hours
of video guides

The very best
walkthroughs around

More than
800 textures
Brought to you by

quality vendors

Hundreds of
3D models 
Vehicles, foliage, 

furniture… it's all there

Subscribe today & unlock the free 
gifts from more than 30 issues

Access our entire library of resources with a money saving 
subscription to the magazine – that’s more than 400 free resources

Unlock 
every 
issue

MMoorree thaann
400000 rreasssoonns
tooo ssuuubscccrribbbee

More 
added 
every 
issue

Head to page 84 to subscribe now



Have an image you feel passionate about? Get your artwork featured in these pages

Create your gallery today at www.3dartistonline.com
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 I tried reproducing the 
mood of an early morning in 

Japan. So with artist Yoii’s 
character and rooftops as a 

focus point, I used a low sun 
to get soft shadows and also 

mostly diff use refl ections and 
a shallow depth of fi eld to 

keep a smooth atmosphere. I 
also used light coming from 

down the street to break the 
shadows on the character

Julien Crochet, 
The Observer, 2016

13

Work in progress…

Julien Crochet
juliencrochet.wixsite.com/
portfolio

Software 3ds Max, V-Ray

Julien graduated from LISAA 
animation in Paris in 2014 and 
now works as a 3D generalist



 I started modelling this robot 
to improve my hard-surface 

ZBrush skills. First I created a 
low-poly version to defi ne a 

basic shape and fi nd the right 
proportions. Most of the robot’s 

protective shells originate from 
that base geometry, which is 
why their shapes match up. 

After the exterior was done, I 
created the inside geometry, 

making sure all parts made 
sense and the joints would also 

work in the real world
Daniël Veder, 

Robot, 2016

Work in progress…

Software ZBrush, MARI, 
Maya, Arnold, NUKE

Daniël is a 3D modeller and 
shading artist. He works at 
INFECTED Postproduction

Daniël Veder
www.danielveder.com

 

14



15

Yonglin Yao,
Tianshi,2016

 In ancient China, there 
is a legend that dragons 

have night children: a 
unicorn is one of them. It 

symbolises auspiciousness, 
power and justice. When 
conquered by Tianshi at 
last, they fi ght for justice 

together. I sculpted the 
character in pose with 

ZBrush, and the hairs and 
beard of the character 

were created in Ornatrix 

Workinprogress…

Software 3ds Max, ZBrush, 
Photoshop, V-Ray 

Yonglin is a 3D character 
artist with experience  
in modelling and hair FX

Yonglin Yao
damonyao.artstation.com
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 I always liked fairy 
tales and this one has 
an emotional context, 

which I thought would 
be challenging to re-

create. I wanted to 
capture the exact 

moment when she 
lights the last match 

and sees her 
grandmother again; 

when the darkness is 
filled with joy again, 

even if it will only be for 
a few hours

Patrick Evrard, 
The little girl with the 

matchsticks, 2016

 

Work in progress…

Patrick Evrard
www.patrickevrard.com

Software ZBrush, Substance 
Painter, Maya, Photoshop

Patrick is a 3D artist whose 
passion for character design 
influences his art



 In fact this work doesn’t 
have any interesting story. I like 
these types of scenes 
spiritually, so this is reflected in 
my works. Also, I surf websites 
featuring these types of 
photos, and I then took some 
of my own favourite photos for 
this piece of work
Volkan Kacar,  
Unknown Location, 2016

17

Work in progress…

Software 3ds Max, 
OctaneRender, Photoshop

Volkan is a freelance 
automotive and architectural 
digital artist

Volkan Kacar
artstation.com/artist/volkan



In depth
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 Partially inspired by the amazing wall cards 
of Magic: The Gathering, my intention was to 

create an immersive image depicting a creepy 
and vivid obstacle of endless teeth, gums and 

saliva – an omnipresent and ever-regenerating 
force that has plagued generations of 

travellers from all walks of life
Mike Kime, Wall of Teeth, 2016

19

Mike Kime
pseudo-pod.com

Software 3ds Max, ZBrush,
V-Ray, Marvelous Designer

Work in progress…

Mike is a 3D artist at Epic 
Games. A dentist’s son, Mike 
knows a few things about teeth



PAINTOVERS AND 3D RENDERS
ABOVE For quite a while I balance the 2D image with what I have in 3D and visa versa. I try different fields of view and cameras in the process. I’m always trying to adhere to my 
thumbnail, but I’m always open to new developments and happy accidents. I take renders and paint over them and then re-create what was painted back in 3ds Max at all cost.  I’ll 
bend, break and warp 3D into what I need.The work-in-progress image featured shows a combination of 3D renders crossed with paintovers.  You can see that I had already deviated 
from the thumbnail and gave the wall of teeth a much taller feel, all achieved by simply scaling the object’s height.

 

 The final 
image is then 
rendered in 3ds 
Max, V-Ray and 
Photoshopped 
until it adheres to 
a relationship 
between values 
and details
Mike Kime,
Wall of Teeth, 2016

CLOTH GENERATION
RIGHT Cloth is generated over a very 

basic version of the character geo. The 
arms on the characters are from a 
universal arm that I pose for many 

images and applications. In this case the 
base body (avatar) is hacked together 

from previous works of art I’ve created. 
This is because you never really see her 
from the front. Note that the folds flow 

towards the centre of the image. This is 
a free win. You can yank the fabric 

around and try to get different flows that 
work with what your illustration needs.

20
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ZBRUSH IMAGE
ABOVE Objects transfer 
quickly from 3ds Max to 
ZBrush and back to keep 

things lined up. I try to 
match perspective as close 
as possible and then sculpt 
to that shot. The characters 

are stubbed in for 
placement and the teeth/
gums eventually get a full 

sculpting treatment.  This is 
brought back into 3ds Max 
for final rendering.  The set 

of teeth you see in the 
ZBrush image are the only 
ones I made. The rest are 

decimated repeats, warped 
and bent around.  In fact, the 

wall’s perspective is faked 
and forced by tapering and 

curving it in space. 

THUMBNAILS/ 
IDEATION
LEFT I start with an idea in 
mind and then I try to 
experiment inside those 
constraints. I created several 
thumbnail images looking at 
the idea from different angles.  
While I do these thumbnails 
I’m trying to think about 
numerous things at once, such 
at the relationship between 
elements, focal points and 
values.  Once the final thumb 
is picked I try to establish the 
value relationships and then 
hold true to that as much as I 
can going into the 3D work.
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how to take command of the free software in order to 
eptional environments, characters and more

f you haven’t tried to use Blender yet then why 

not? You can sculpt and model, unwrap 

meshes, composite, perform simulations, create 

ames, edit footage for fi lm, render in GPU or 

PU, render physically accurate shaders and 

uch, much more in Blender – and best of all, you 

an do all of this without spending a single penny. 

n top of that, it’s open source and the code is 

eing improved all the time by a dedicated 

ommunity of Blender users and developers. 

It may sound slightly grassroots, but Blender 

as actually been used to deliver shots for feature 

ms, such as fi rst-person action movie Hardcore 

enry and others. VFX supervisor Yaroslav 

emnits from Division LLC explained that this was 

thanks to the software’s innate fl exibility and 

modern toolset. The fi fth fi lm from the Blender 

Foundation, Cosmos Laundromat, is an animated 

fi lm currently in development that even has the 

fi rst 12 minutes viewable on Netfl ix US – not bad 

considering it’s been solely created in software 

that costs absolutely nothing and gets part of its 

maintenance from its own users! 

Beyond being able to work with visual eff ects 

and animate, there are an abundance of Blender 

features to try out to help you texture skin, groom 

fur and feathers or even create abstract art. So 

why not try it today? Over the next few pages 

you’ll discover projects that’ll help you tame the 

software in order to create exceptional art.

DER
OJECTS

MASTER             ASTONISHING



01 Plan yourmodelA good 3D model starts 

with a good concept. Choose an image that 

you like and break it down into its simplest shapes 

by drawing over it. This will help you plan how you’ll 

approach modeling your character. I used Ryan 

Lang’s ‘Kappa’ concept. This is an ideal concept, 

providing material and lighting references for our 

final render.

02Model and sculptNext you will create 

your character’s base mesh. You can either 

PolyModel it or use Blender’s Skin modifier to 

generate geometry. Then separate any complex 

parts of your mesh, such as the head and hands. 

You can use Dynamic Topology sculpting on these 

parts for creative freedom while minimising the 

amount of retopology necessary.

03 Retopologise and textureOnce you’re 

happy with your sculpt, retopologise it, 

keeping your topology as clean as possible and 

reattach the separated parts. Now you can UV 

unwrap and paint/bake your Diffuse, AO and 

Cavity texture maps. Be sure to use Blender 2.78’s 

viewport material preview to see your Displacement

map in action as you paint it.

04 Shade and lightGo ahead and set up 

your lighting. Be sure to add an

environment texture to achieve proper reflections, 

then begin creating your shaders. Shading is

probably the longest part in the whole character 

creation workflow and is extremely important to the 

quality of your character. As you’re creating shaders, 

use references to help achieve believable materials.

05 Rig andpose your characterAt this 

stage you need to see how your shaders 

will react in your final render, so add an armature to 

your character and put him into a pose. I highly 

recommend creating as advanced a rig as possible, 

since a better rig will allow you to achieve more 

detail in your pose.

06 Render it out and compositeNow 

that you have your lighting, shaders and 

pose, it’s time to start crafting your final render. This 

part of the process is primarily adding small details 

and adjusting the various aspects of your render  

until you’re happy with it. Compositing is the cherry 

on top, putting that final polish on your image.

Create unique 
characters
A quick look at a character creation workfl ow 
highlighting some of the new features in 
Blender 2.78

1

01 02 03

04 05 06

BEFORE AFTER
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CGgeneralist
oceanthebard.artstation.com

DANIEL
PEDERSEN



Learn to tackle 
microdisplacement
Learn how to set up and optimise the new
experimentalmicrodisplacement feature in
Blender 2.78

2
01 Enable themicrodisplacement This

feature is still in the experimental Cycles

engine, sowe’ll have to set that up first.With your

renderer set to Cycles, go to the Render tab and

select Experimental in the feature set.

Microdisplacement uses lots of RAM, so you can

experimentwith CPU andGPU rendering if you’re

gettingmemory errors.

02 Prepare themesh Beforewe add the

material, we’re going tomake surewe have

our object set up properly. Ensure that you have a

cleanmesh topologywith evenly-sized quads. In the

Modifiers tab, add a Subdivision Surfacemodifier

and set it to Adaptive. Thiswill enable the

displacement to subdivide yourmesh.

03 Create thematerial In theNode editor,
create a newMaterial for your object. Add

a texture (either an image or a procedural texture)

and hook it up the theDisplacement slot of the

Material Output. To control the size of the

displacement, insert aMath node set toMultiply

between your texture and theDisplacement slot.

04Activate the displacementNow it’s

time to set up themicrodisplacement in

theMaterials settings. Opting to set it to Bumpwill

use your displacementmap as a bumpmap, while

Truewill actually displace yourmesh and iswhat

we’re going to use. If you opt for Both, it will displace

yourmesh and add the bumpmap on top. This can

help in some situations, but it tends to produce

exaggerated results.

05 Control the displacement In the
Cycles render settings you’ll find a

Geometry section. Herewe can adjust the

Subdivision Rate. Cycleswill try to subdivide your

object until its polygons are the size in pixels of the

subdivision rate in your final image.

06 Geometry settings tricks Keep in
mind thatwhen your final render

resolution increases and the Subdivision Rate stays

the same, Cycleswill subdivide your objectsmore to

attain the polygon size set. Sowhen increasing your

render resolution youmightwant to either increase

the Subdivision Rate or decrease theMax

Subdivisions in order to avoidmemory issues,

depending on your scene.

01

02

03

04 05

06
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Pixel wizard
www.themantissa.net

MIDGE 
SINNAEVE



Non-destructive
modelling
Build sophisticated characters and scenes in
Blender by learning how to work non-
destructively in a component-based workflow

01MethodologyAcomponent-based

modellingworkflowmimics real life, where

complex objects are assembled fromnested

sub-objects. In Blender these objects are

systematically instanced using differentways of

data linking. Complex forms are derived

procedurally from simplemeshes bymaking use of

Blender’s powerfulmodifiers. This nearly fully

non-destructive and non-linearworkflow results in

extreme efficiency and the ability to develop

complexitywithout anymajor time penalties.

02 Create basic objectsAfter the design
has been prototyped eitherwith a 2D

concept or through a 3D sculpt, a light polygonal

topology needs to be created. By relating to objects

as they are in real life, each component (such as

chest plate or shoulder pad) should have a unique

mesh.Modifiers such as Solidify, Bevel andMirror

should be added early on in the process. This

enables you to explore designwith very light and

easy-to-editmesheswhile themodifiers give you a

preview ofmore complex final forms.

03 Crease andBevelWhenworkingwith

(open)subD, it is a good idea to use Edge

Creasing to create sharp edgeswithout unnecessary

extra edge loops. Blender also offers procedural

edge bevelling through use of BevelModifier

(Weightmode). This creates actual edge loops to

give nice and sharp bevelled cornerswithmany

parameters to control the look. Advantageously it

does not require heavy subdividing to see the result.

3

04Make themost ofmodifiers The
Edge Splitmodifier can be used in

combinationwith Solidify and Bevel to create

panel-like structures. The Screwmodifier serves as

a perfect base for creating round surfaces from2D

polygonal edges. The Skinmodifier can be used to

create lattice-like structures fromnothingmore

than edges, while theDisplacemodifierwith

asymmetrically stretchedUVsmakes excellent

wrinkles for cloth.

05Arrays andBooleans TheArray
modifier can be used for 1D arrays, 2D

(grids) and also circular arrays. In combinationwith

the Latticemodifier they can be put into any shape

needed. The latest version of Blender comeswith a

very fast BMesh BooleanModifier.Whatmakes it

exceptionally powerful is that Booleans can be

stacked on anymodifiers used before and after

themaswell as on the Booleanmeshes themselves.

06Workwith componentsAs the
complexity of the scene grows, so does

the frustration ofmanaging all the objects. Blender’s

Scenes feature can be utilised to isolate any

component into an empty scene. Thatway it can be

treated as an independent artwork inmost

comfortable editing settings (zero transformations,

no clutter, fast rendering). The data between scenes

is systematically shared throughDupliGroups or

Data linking. This enables comfortableworkwith

the componentwhile being able to see live updates

in all scenes and objects related to it.
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What’s new in 
Blender 2.78?
Blender 2.78 is a huge update to the software, 

with a new Freehand Curve drawing tool, a 

new Dissolve tool, a new Fill Region tool for 

Selection, the animation tool Bendy Bones 

being vastly improved, changes to streamline 

the setup and changes to drivers, support for 

non-uniform scaled bones failing with IK 

solver, stereoscopic VR support for Cycles, a 

Multiscatter GGX mode, glassy and gloss 

BSDF nodes, a better subdivision and 

displacement system, adjustable cloth 

simulation speed, animatable cloth rest 

shape, additional shading features for the 

Blender GLSL viewport, improvements to the 

user interface, Alembic support and a 

completely reworked Grease Pencil. 

“My favourite feature of Blender 2.78 so far 

is probably the accelerated rendering and 

memory optimisation,” explains Daniel 

Pedersen. “They have made shader 

development much more enjoyable. The 

improved viewport and real-time 

displacement have been very useful as well.”
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Texture skin and set up 
facial hair
Here’s a skin setup, one of 12 different setups I regularly 
use for skin texturing in Blender and Cycles. All maps in 
this example are at a 4K resolution

4
01 Prepare the human First we’ll create a 

human via DAZ 3D (man/female Genesis3)

without make-up or hair. In Blender we’ll be setting 

up the hair and facial hair. After the work is done, 

export the figure as an OBJ file. For the export a 

better choice is mcjTeleBlender 3. Here in the 

Export settings it’s very important to choose Collect 

Maps and only export the current frame – we don’t 

want any animation!

02 Prepare the maps We’ll take the original 

diffuse map, which was exported from 

DAZ 3D (in this example, the Face map) into

Photoshop. With the Google NIK Collection (which 

you can download for free online), use Vivezia 2 and 

set only the Structure in this filter to +45%. Confirm 

by pressing OK. Save this image as a JPG – for 

example ‘Face-DIFF.jpg’.

03 Create other maps The next step after 

the processed diffuse map is to now create 

the displacement and specular maps. For the 

displacement map, use the following settings in 

Photoshop: set Hue/Saturation from this Diffuse 

map to 100%, Brightness/Contrast to 0/45. Now 

collect all visible layers on a new layer and invert the 

image. Go to the NIK Collection (Vivezia 2) and set 

the Structure to +20% and save this image as a JPG.

For the specular map we’ll use the following method 

in Photoshop: delete the layer with the displacement 

image. Only the layers with the processed diffuse 

map, Hue/Saturation and Brightness/Contrast 

should be visible at this point. Leave the Hue/

Saturation at -100%, Change the Brightness/

Contrast to -15/78. Merge all visible layers into a 

new layer and invert the image. Choose NIK

Collection (Vivezia 2) again and set the Structure to 

+20%. Save this image as a JPG.

04 Prepare the height map For the height 

map we’ll use Substance B2M. Take the 

processed diffuse map Face-DIFF.jpg and load this 

image into B2M. choose ‘Load in Main input tweak’ 

and change the output size to 4096. Now export it 

as a Bitmap and choose only Height (id:height) and 

set the format as TIFF. If you need a very good brush 

in Blender, such as bricks, rock or walls, you can also 

use B2M. Put your image in B2M and go the same 

way. Set resolution between 2048 and 4096 and 

save as a height map. Open Sculpt mode in Blender. 

Go to New Texture, and under Properties>Texture, 

load a new brush texture and choose the height 

map you created via B2M. We’ve made good 

progress with this step.

05 Create the EXR maps To create the 

EXR maps we’ll use Luminance HDR 

(www.qtpfsgui.sourceforge.net). Load all of the 

maps (in this example the maps we created, 

Face-DIFF.jpg, Face-DISP.jpg and Face-SPEC.jpg) 

into this software. Choose New HDR Image. If you 

see the warning EXIF Data not found, press OK and 

set the EV to 0. Press Next and Finish. Change the 

Result size to 4096x4096 and the Operator to 

Mantiuk’06. Set the Contrast Factor between 0,10 

and 0,30, Saturation Factor to 0,80, and the Detail 

Factor between 1 and 5. Now press Save As and give

the image a name. Repeat these steps with the 

displacement map and the specular map. 

06 Set up Blender We’ll take the diffuse, 

specular and displacement EXR maps into 

the Node setup. Instead of the displacement map 

we could even use the height map – especially for 

outdoor scenes with HDRI light. All Skin Node 

setups have a Translucent node and Color Gamma 

node for the skin (main skin gamma 6-8), ears and 

nose for example (gamma 3-4), which means more 

translucency. DAZ delivers the maps for the face, 

arms, legs and torso. You can repeat the steps for all 

of the body parts.
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Build your own 
environments
Learn a typical environmentworkflow
fromone of the artists behind open
Blender project, ‘TearsOf Steel’

5
01Get inspirationWhen creating a large

environment, it’s important to find some

inspirational images, as thesewill help you find the

rightmood. Even if you have a clear concept inmind,

try to find references thatmatchwith the visuals in

yourmind. Think about light and atmosphere, too.

02 Block andmodelMake a rough sketch

and blockmodel of your scene. The sketch

can be used as a blueprint, while the blockmodel

helps you tomake a first composition and shows

you howmany objects you need tomodel. Don’t go

intomuch detail, as it’s just a quickway to visualise

your idea.

03Organise yourworkflowMake a time

schedule for when you need to create the

scene. If you have threeweeks, calculate howmuch

time you have for every object. Think about

scheduling some time for the building process,

scene development and the post-production setup.

04 Create buildingfiles I always start by
designing the buildings. Formywork

Germania, I startedwith the tower and after that I

completed all the smaller buildings. I made a library

filewith all the buildings and saved it separately. I

alsomade a nature filewith rocks, grass and trees.

05 Put the scene togetherNowyou can

start appending and linking the buildings in

your scene. If change your composition, try to stay

close to your original idea.When all the buildings

are in the right place, you can import objects like

rocks, trees and othermain scene properties.

06Addpost-production The realmagic

happenswhen playingwith atmosphere

and light. It is key to blend everythingwith each

other. Think about light layers to add depth in the

scene. Avoid image effects, as the best artworks are

the ones that don’t need in-depth post-processing.
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Expert shaders and 
feather creation
With dynamic topology, sculpting tools and 
the Cycles render engine, Blender now allows 
you to create animals in no time at all

6
01 Flesh out your concept The first thing I 

do (as I’m not a concept artist and don’t 

have mind-blowing ideas) is to find an idea to work 

from. I opted for an amazing concept by Svetlana 

Bukanova and set it in my UV editor as a reference.  

You can then create a base mesh with the Skin 

modifier or, as shown here, block a base mesh with 

a Mirror modifier, a Subdivision modifier and 

extrude a very basic bird following the reference.

02 Base sculptUsing Dynamic Topology 

sculpting with a pretty high Detail level, we 

can first define the main shape, trying to match 

proportion with the reference. Add a sphere to 

create the eye and add a Mirror modifier to it.

03Add the coloursYou can refine the 

sculpt using Pinching and Creases to mark 

some sharp edges. We’ll then apply a Decimate 

modifier to reduce the polycount, keeping a good 

level of detail. With Vertex Painting mode enabled, 

we can roughly add colours. Use a high amount of 

Jittering to your brush to create coloured dots.

04 Base shadingAt this stage I set my 

shaders for the areas that won’t be

covered with fur or feathers. We’ll use a good 

amount of modified Fresnel to drive our glossiness 

and diffuse colour using a Color Ramp with multiple 

contrast steps. It’s a good way to get a cartoon feel 

to your model.

05 Build feathersCreating feathers can be a

pain, so instead I’ve created fur with a 

pretty low number of strands and I’ve used Children 

particles with a lot of clumping to get the feather 

shape. Then it’s a matter of combing and vertex 

grouping to get the right density. I’ve used a good 

amount of Fresnel to contrast the feathers’

appearance, too. Bigger feathers were created using

a simple extruded cube with fur on each side.

06 Prepare to render I’ve quickly sculpted 

the branch, used a procedural wooden 

texture upon it and added a particle system to 

create the moss. I’ve also added some back-facing 

translucency to the moss to fake a subsurface 

scattering effect. I’ve also rendered few passes, such 

as AO and Glossy, and combined these in

Photoshop. I’ve used a rainforest picture that I’ve 

blurred a lot to create the background.
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I
magine being able to wake up at essentially

whatever time you need to, go for a morning

jog, have breakfast and go back to bed before

you even begin your day’s visual effects work in

your home office. Then imagine doing that for TV

and film titles no matter where you live in the

world: whether it’s the islands of New Zealand,

the rainforests of Australia, or by the ports of 

Pennsylvania. For many in the industry, and across 

the VFX hubs in London, Los Angeles and

Vancouver, this is likely an unattainable dream.

But, for VFX Legion, it’s very much everyday life.

In just over three years since its inception, VFX

Legion has already worked on a variety of shows

and feature films including Hardcore Henry, The

The prolific visual effects team reveals to
3DArtist how its artists manage to collaborate
on projects despite being continents apart

Purge: Election Year and How To Get AwayWith

Murder. Founder and creative director of VFX

Legion, James David Hattin, explains why being

able to give artists the ability to work remotely

from home is attractive, and not just to the artists

themselves: “It’s a better quality of life for the

artist and when you have better artists you get

better work, and for the production side – the 

client-facing side – we have the ability to tap the 

best resources for that particular project. We don’t

have to have a large facility with in-house artists

and overheads like the traditional structure. We’re

able to pull from the best resources available all

over the world when they’re needed and basically

give our clients the best bang for their buck.”

Christopher 
Sinnott works  
in-house with 

Shotgun at the 
Burbank office in 

California
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From a central production hub in Burbank, 

California, VFX Legion employs 35 artists that 

work either in the 200-square-foot offi  ce or 

remotely from all over the world. For senior 

compositor John R McConnell, this remote work 

goes beyond being able to access work from any 

computer in his home. “I’m an avid theme park 

goer; we often go to Disneyland, Disney World 

or Universal Studios or whatever, so 

even when I’m out and about and 

a coordinator or somebody 

says, ‘Oh hey can you 

upload whatever fi le?’, I 

remote in on my phone, 

go into my home 

computer, navigate to 

the fi le and upload it.”

To help artists 

communicate, VFX 

Legion utilises Zoom 

for video chatting, 

Aspera for secure fi le 

transfers and Shotgun for 

notes and fi rst-pass reviews.

“The fantastic thing about 

how Legion works is we’re using a 

dedicated shared fi le server through Aspera 

and we’re using tracking software Shotgun to keep 

track of everything,” says McConnell. “So if I just 

need to upload a preview of something, then I 

upload a preview to Shotgun… and I can just totally 

do that from my phone. I’ve done that multiple 

times where I’m standing in a line for a ride.

“I can be anywhere and do my job – I can’t really 

trade that for anything. I don’t know of any other 

type of shop that allows me that kind of freedom. 

So that’s like the number-one thing for me, there’s 

not that pressure to be in a specifi c place at a 

specifi c time.”

Other tools are written in-house for ingesting 

and delivering assets. The standard software used 

by artists, though, just needs to be their most 

comfortable tool, says Hattin: “For the remote 

artists, they just need to have NUKE, After Eff ects 

or Maya. We have a strict folder structure that 

they can work in. It’s not a unique way of working 

but we have a set way of working – so a lot of it is 

off  the shelf and that’s really empowering as it’s 

not reliant on custom tools to the artists out in the 

world. We thought about that early on.”

“The onboarding process for new 

artists is not very detailed, it’s 

just some basics but it’s good 

for them because as long 

as they have the 

software package that 

they’re good at they 

can get to work 

easily,” says Matthew 

Lynn, VFX supervisor. 

“We also off er some 

rentals of licences, of 

software packages, in case they 

don’t have their own so they can use 

our VPN and pick up one of our licences. It’s 

relatively simple for new artists to get to work.”

Working from home across an abundance of 

time zones means that the artists can provide an 

almost 24-hour working cycle for VFX Legion. It’s 

a very diff erent model to typical VFX facilities, as 

senior compositor H Haden Hammond tells us.

“It’s defi nitely a lot more organic. For me, I have 

kids so we have to kind of work whenever it works. 

It’s not always nine to fi ve, it’s sometimes after 

they go to bed or late at night depending on if 

there’s a deadline, then I can work late and get up 

early and check it. I still work just as much in terms 

of hours in the day but they’re not back-to-back, 

which kinda gives me a chance to experience life in 

between just a bit more… That’s the big diff erence: 

A DAY IN THE LIFE OF A LEGIONARY Senior compositor John R McConnell runs 
through a typical day working from home

I get up and rustle

my children to get

out of bed, to get

them dressed, to

go get breakfast,

get all of their

stuff, and get in

the car.

6am-6:30am

We’re out of the

door with a

45-minute round

trip in the car to

three different

schools that are

halfway around

the city.

7:15am

I come home, and 

will – depending 

how late my night 

was the night 

before – either 

have breakfast or 

go back to bed for 

an hour.

8am

 This is a new way 
of working. We’re 

one of the only 
successful facilities 

to do this
James David Hattin, 

creative director
and founder
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Get up, check my emails, see if there are

any 911 emergencies from work. If not

then I’ll go and figure out what I’m doing

for the day. If I’ve been working on a

shot the night before, I’ll get back to

work on that, or I go and see if there are

new links to Shotgun saying, ‘Okay go

do this’. Then I work for several hours.

9am

Lunch. I’ll

occasionally have

it before I pick up

the kids… or I’ll

grab something on

my way out as I

occasionally forget

to eat!

1:30pm-2pm

Get home, work

for around a few

more hours. Wife

gets home – she’s

a kindergarten

teacher. Usually

we’ll then sit and

chat for a little bit.

3pm-5pm

My wife usually

conks out around

this time and I go

back to work.

9pm-10pm

Stop working for

the day.

1am-2am

Hammond says 
he wouldn’t be 
able to work 
remotely without 
his wife‘s support

35

VFX Legion has delivered 
visual effects for two 

seasons of How To Get 
Away With Murder 
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it’s not all home and then all work. It’s kind of all 

intermingled together.”

Artists can be salaried weekly at Legion or their 

assignments may be more sporadic. The work is 

based on their own specialism, and the hours that 

Legion allocates are based on a pre-written hours 

list that is given to the client. “The hours are times 

whatever the money is. Here in the US, it’s $50 an 

hour so that’s $400 for eight hours. If you can do 

the shot in two hours, you still get $400,” explains 

Hammond. “Conversely, if you do ten hours you 

still get paid $400. Our goal is, generally, that the 

artist is done in about half the bid time. That’s the 

ideal – there are times when it goes over and there 

are times when it goes remarkably under. 

“I’ve [previously] given an eight-hour shot and 

they got it done in an hour. I’ve had people guiltily 

ask me, ‘Am I really going to be paid $400 for 

this?’ That’s sort of how the system works! So next 

time you get screwed – we’ll get it back! We’ll find 

a way!” he laughs.

 It’s a lot of trust to put into the artists, but 

Hattin explains that this is thanks to a policy of 

predominantly hiring more experienced, senior 

artists for VFX Legion. “We can go to sleep and 

somebody in Australia can be working their day 

and we do a handoff, we communicate at the end 

of our day and the beginning of theirs,” he explains. 

“We feel comfortable knowing that they’re going 

to get through what they need today without us 

being right next to them or taking a look at every 

step. Most cases, we wake up the next morning 

and their work is on our server and ready to go.”

They tend to be a certain kind of person, too. 

“We’ve found that the people who fit with our 

model, that gel with the way that we work, they’re 

very invested in the work that they do so they give 

it their all, whereas you get people in a facility who 

drag themselves to work. They don’t really want to 

be there, they don’t want to spend 16 hours a day 

there, they’re just trying to get through the day. 

The people who are at home are invested in the 

shots they are given, they feel compelled because 

it’s their name on the line. It’s all about them, 

because there isn’t a supervisor micromanaging.” 

“I think anybody will want to work from home 

but I definitely think you need to be a self-

motivated person,” suggests Hammond. “You 

need to be able to manage your time and realise 

how long something is going to take and just really 

be motivated to get it done in the amount of time 

that is asked of you.”

While time management can be a challenge, 

deadlines can be even tighter, as Hattin explains. 

“These days we have a lot of TV shows – their 

schedule is very tight and they don’t get to lock 

their cut as fast as they’d like so we end up getting 

three or four days to do 100 shots, which is a very 

fast turnaround. A normal feature film facility 

would take six weeks to do that, and we’re being 

asked to do it in a few days, so that’s the challenge. 

It’s not really anyone’s fault. It’s just one of those 

things where the network has notes, the editors 

Hattin with his 
son David, who he 

can spend more 
time with thanks 

to Legion’s model

VFX supervisor 
Matthew Lynn 
is based in 
Los Angeles

The Catch is just 
one of three 
ShondaLand TV 
shows that VFX 
Legion works on

The Burbank studio 
is a production hub 
that the creative 
workforce is 
centred around
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VFX LEGION’S 
PROJECTS OF 
CHOICE
The team tells us about some of its 

favourite and most memorable projects

James David Hattin: “Ciaran Foy, who 

directed Sinister 2 – we’ve become friends 

after working on that movie. I was on set for 

the reshoots. We just got to talking, we sat in 

the edit bays and we worked through shots. It 

was just a really successful relationship – 

that’s the stuff that’s really enjoyable. When 

you get to work with good people who want 

good work, they know what they’re asking for. 

When they’re asking for the impossible, they 

know they’re asking for the impossible, and 

they respect the hell out of you for delivering 

on things that they thought couldn’t be done.”

H Haden Hammond: “Probably Jem And 

The Holograms, because it was creative. It was 

more than just making something happen 

that you would see in real life and replicating 

it, there was some creativity to it to make it 

look cool. It was the hologram with the dad 

talking to the daughter, to Jem… It wasn’t a 

super popular movie but it was a touching 

scene and I looked forward to watching it with 

my family. So that was a big motivation, like 

when I am working on something that I know 

is going to be good that’s a big motivation.”

John R McConnell: “My most favourite/

least favourite was Hardcore Henry! Hardcore 

Henry was bonkers. I remember James [David 

Hattin] showed me a rough cut of it and I said 

‘I have to work on this’ – that was before I 

knew it was entirely filmed on GoPros! And 

GoPros are a nightmare because they have 

fisheye lenses and anything you do to it, you 

are at the mercy of a highly distorted image. 

It’s also highly compressed so you get MPEG 

artifacts in the different channels of the 

image. So if you’re pulling a luma key… you get 

boxy compression in the individual channel 

because you can’t get a clean luma key.”

have to do the notes. Then suddenly you find out 

that they locked the cut and oh, it’s due in three or 

four days. We get it done but it creates long days.”

There’s also the difference in hardware at home 

compared to the render farms at a typical shop, 

says Hammond. “At a big studio, you would have a 

giant render farm that you can just send 

everything to and get it back right

away. It is something I plan on

down the road, getting a 

machine that renders for 

me, but right now I’m just 

working on one machine 

so that can fill up with 

shots that are 4K. If it 

takes a lot of time to 

render them then you 

have to wait for that to 

turn around before you can

get at it again. You have to

manage your time pretty smartly.

If I’m not in my office then I have to be 

rendering something because you always learn 

something from a render.” 

Hattin admits that there can be some clarity 

problems with notes in Shotgun, too, leading to 

confused artists. “Communication can still be an 

issue, notes can be unclear. Sometimes people 

can address the note a wrong way because of the 

lag time or because they’re on the other side of the 

world. This could add a few hours onto 

getting it all in sync again and I think

that’s the biggest hurdle – 

getting us to communicate

more effectively.”

For McConnell, 

though, it’s the physical 

communication part 

that he misses. “I think 

just having a lack of 

collaboration with my 

other artist friends, like one

of the things I truly enjoyed

about working in an office is working

with artists who are at my same level and 

working through methodology. 

“It’s definitely a very different vibe. I do miss 

some aspects of it but I swear the benefits far 

outweigh the negativity.”

Indeed, coming from a previous position as VFX 

supervisor at Flight 33 Productions, McConnell 

previously had to travel 47 miles twice a day. 

Reducing that commute has vastly helped with his 

home life. “It’s fantastic because my quality of life 

has dramatically altered, and the fact that I can 

drop my kids off at school and pick them up, that I 

can go to parent-teacher conferences – you know, 

I’m teaching my son to drive right now.”

Hammond speaks of a similar benefit in being 

able to spend more time with his children. “I’m 

working just as many hours, maybe even more 

sometimes, but I get to see [my kids] more. If 

something interesting happens at home, 

something that I would miss if I 

was someplace else, I can just 

come out of my office and 

experience it, even if it’s 

just for ten minutes, 

and go back to work. 

It’s a huge blessing. 

And being able to 

work in my pyjamas 

is huge! I’m always in 

pyjamas, it’s almost a 

work uniform – it’s a 

dream come true.”

VFX Legion’s unique 

model has so far yielded 

excellent results. With a 

huge influx of work across TV 

and film in 2016, Hattin expects its 

team will grow to 50 in 2017. But Lynn suggests 

that exponential growth will be deliberately 

avoided. “The one thing we don’t want to do is to 

expand so fast that we become more like the 

traditional facilities. We like the model, and the 

type of artists and the personalities it attracts.

“There are a lot of things with traditional 

facilities that you have to do in order to take on 

2,000 shots overnight, and we’re not 

that company right now and we 

don’t want to be.”

“We want to be really 

good and really agile at 

what we do. We were 

able to start the 

company with a lot of 

off-the-shelf 

technologies, and do 

a thing that other 

companies haven’t 

been able to do,” says 

Hattin. “I was at 

Industrial Light & Magic 

in 2006 when they tried to 

remote workflow and, at the 

end of the day, they had to pull a 

lot of the work back into the facility in 

San Francisco because it couldn’t get done. We 

were designed from the ground up to be this 

remote thing, so that’s allowed us to be flexible 

and we don’t want to burden ourselves by being 

inflexible. Because this is still going to change, 

everything about this is going to change and we 

just have to stay on top of it. This is a new way of 

working. We’re one of the only successful facilities 

to do this, one of the other ones that started has 

gone out of business. So it’s just about being lean, 

being mean and getting work done.”

 I can be anywhere 
and do my job… I don’t 
know of any other type 
of shop that allows me 
that kind of freedom 

John R McConnell, 
senior compositor

 I’m working just as 
many hours, maybe 

even more sometimes, 
but I get to see [my 

kids] more
H Haden Hammond, 

senior compositor
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We take a look at the current state of play for six 
of the most popular videogame engines around 
and grill the talented artists that are using them

engines available. Researching your options will 

help you decide on your requirements and which 

game engine is best for your project. Deciding 

whether you need a fully-featured engine with 

stacks of tools and features or a more streamlined 

solution is ultimately dependent on your creative 

vision, budget and goals. To help you with your 

search, 3D Artist approached a range of 

professional artists working with Unreal Engine, 

Unity, CryEngine, Stingray, Lumberyard and 

Blender to discover their favorite aspects of 

working with their chosen engine and to share 

insight into how that makes their work more 

productive and of a higher standard.

M
aking videogames is a craft that is only 

becoming more and more sophisticated 

as new developments and technology 

– such as the recent explosion of VR content – 

push the boundaries of what’s possible. The 

backbone is the game engine, and unlike 3D apps, 

which artists can opt to switch between fairly 

easily, you’ll want to put your eggs in one basket 

to a greater extent and choose wisely. Switching 

engines in production is not impossible but can be 

costly and is certainly undesirable.

There has never been a more exciting and 

challenging time to start creating content with any 

of the increasingly accessible and powerful game 

39
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“Unreal Engine 4 has to be the weapon of choice

for my personal projects. The powerful material

and lighting system is embedded in an easy-to-

navigate and master UI, and this gives me

everything I need to create my side projects.

“For me, I enjoy the simplicity of the engine to

start with and how it’s still complex enough to

achieve unique ideas. Materials and lighting work

well together and, combined with the strong light

map solution, it’s possible to achieve stunning

results with minimal fuss. An incredibly vast

UNREAL
ENGINE

Hugely popular, Epic Games’ Unreal Engine has

won countless awards and is a popular choice

for both indie and triple-A development teams

amount of diff erent styles can be carried out 

using just that toolset.

“For my Sunrise scene I wanted to create a very 

moody and stylised lighting situation and yet still 

use realistic materials. Unreal Engine 4 provides a

broad range of effects that I can rely on to help

me to achieve my vision, and for this example I

used the Exponential Height Fog on top of an

Atmospheric Fog to create a more interesting

colour palette.

“One of the strongest parts of Unreal Engine 4

is the Material editor. It’s a node-based system

that can create solutions for most problems. I like

having the flexibility to share textures throughout

my materials. For example: using a Green Channel

of a Grunge map multiplied by 0.5 on the ground

material and the Red Channel, of the same

texture, added to the brick material for the bridge.

It’s ideal when it comes to saving texture memory

and time re-using the same textures in different

ways, but it could easily get lengthy to create the

same basic node setup for every material again

and again and for that there are material

instances available. The rendering features are

top notch and are frequently updated, too. UE4

also comes with optimisations to increase frame

rate for the real-time engine.”

---------------------------------------------------------

MARTIN TEICHMANN

Environment Modeler 

Naughty Dog

www.martinteichmann.com

---------------------------------------------------------

“Sunrise is a stylised 
landscape rendered in 

Unreal Engine 4. I 
wanted to experiment 
with strong colours to 

create unique 
atmosphere and mood 

for this environment”

PRICE: Free, royalties when releasing a game
 
USED FOR GAMES INCLUDING:
Street Fighter V, Paragon, Mortal Combat X, Shadow Of The 
Beast, Gears Of War 4

MINIMUM SPECS: 

or later

faster

5 KEY FEATURES:

PROS:

CONS:
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“Making 3D art with CryEngine over the years has

really made me appreciate one of its biggest

strengths: the ease with which it allows me to

create great-looking assets and scenes. Physically

based rendering allows consistency in the visual

quality of different lighting setups without having

to adjust textures each time the lighting changes.

An asset on which textures were tweaked in a

neutral lighting setup will work everywhere else,

too. Following PBR guidelines also ensures visual

consistency on assets created by various artists.

When working on an asset in a 3D program it

only takes a quick export to see changes in the

editor. The same goes for creating and updating

textures. With Substance Painter, textures can be

exported and loaded in the Material editor so

every new export from Substance Painter shows

up in CryEngine.

“With Volumetric Lighting and Fog Shadows,

new and enhanced lighting features came into

CryEngine and provided more options for creating

photorealistic environments. The Voxel Based

CRYENGINE

Crytek’s next-gen VR-enabled game engine

CryEngine V uses a ‘pay what you want’ basis

for its business model

---------------------------------------------------------

SINA ELS

Senior 3D Artist 

Crytek

www.sinaels.com

---------------------------------------------------------

Global Illumination system creates large-scale 

AO and indirect light bounce for even better-

looking results without any extra work for the 

artist. Furthermore, vegetation features like 

Touch Bending and Detail Bending lead to a more 

believable gaming experience. CryEngine’s 

performance is really good, even with the 

heightened FPS demands of VR compared to 

traditional console titles. That means that I can 

populate my scenes with a lot of assets. Having 

worked on VR titles for PlayStation VR and 

Oculus Rift I can confi dently say that CryEngine 

really shows its power when it comes to creating 

VR games. Even though the highest demanding 

features are reserved for high-end development, I 

feel I was still able to create very satisfying art for 

VR with CryEngine.”

 CryEngine really shows 
its power when it comes to 

VR games

PRICE: Pay what you want
 
USED FOR GAMES INCLUDING:
Star Citizen, Evolve, Homefront: The Revolution, Everybody’s 
Gone To The Rapture, Ryse: Son Of Rome

MINIMUM SPECS: 

5 KEY FEATURES:

PROS:

CONS:

04 Check multiple animations se 

REVIEW A FINAL 
CHARACTER MODEL
Crytek’s Alvaro Cañizares shows how to 

improve a character by seeing it in motion

01 Prepare the scene 

02 Load the character 

03 Search animations 
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“Unity is a very intuitive, user-friendly engine that

allows you to create a diverse variety of games,

both in game mechanics and art style. I’ve used it

within small teams to rapidly iterate game

prototypes in pre-production, as well as on longer

projects, which required attention to detail such

as fine-tuning character materials.

“It’s important as an artist to be able to work

on assets with real-time feedback, and Unity is

great for being able to instantly show updated

textures, as well as having the Scene view, which

provides accurate representations of your assets

without having to spend time building the game.

UNITY

Unity is a cross-platform game engine by Unity

Technologies and is used to develop games for

PC, consoles, mobile devices and websites

---------------------------------------------------------

BLAIR ARMITAGE

3D character artist 

Freelance

www.blairarmitage.artstation.com

---------------------------------------------------------

Broken Window 
Studios’ Reflections 
uses an ink shader built 
into Unity 5, as well as 
various post-
processing effects

Unity 5 has a lot of in-built systems, which 

makes it easy for artists to jump into diff erent 

areas of specialisation. The particle system along 

with Unity’s video tutorials made it easy for me to 

create both basic and more complex visual 

eff ects within a matter of days – the Asset Store 

was also a great resource to purchase various 

eff ects prefabs to use as placeholders. 

“Along with VFX, I was also new to animation, 

and Unity’s Animation Timeline made it easy to 

create simple 2D animations for both game 

assets and UI; the Animator tool lets you easily 

hook up your various states with a visual 

interface. Also in version 5, post eff ects are 

integrated into the engine, which previously 

required third-party plugins. Image eff ects like 

colour correction and tone mapping allow you to 

integrate Photoshop’s tools into your workfl ow to 

create LUTs (lookup textures), which can be used 

with both 2D and 3D game projects, allowing you 

to easily tweak colour temperatures – this is 

especially great for projects with a stylised and 

unique art style. 

“There’s wealth of information available on the 

Unity forums, which makes troubleshooting and 

bug fi xing a much smoother process due to the 

active community.”

PRICE: Personal – Free, Plus – $35 per seat/month, Pro 
– $125 per seat/month
 
USED FOR GAMES INCLUDING:
Firewatch, ReCore, Mobius Final Fantasy, Hearthstone: Heroes 
Of Warcraft, Fallout Shelter, Cities: Skylines

MINIMUM SPECS: 

5 KEY FEATURES:

PROS:

CONS:
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“The key thing when choosing an engine is to look

at what kind of project you want to build.

ForWarhammer: End Times–Vermintide, we

needed a flexible, multi-platform engine that

would allow us to iterate content quickly. As

co-founder of the Bitsquid engine, now Stingray,

we’d been part of its development from the off, so

we were very familiar with it and knew it would

allow us to get the job done. The engine is

well-suited for smaller and mid-sized teams like

ours with very quick iteration cycles; it allowed us

to develop a great multi-platform game at a pace

that would normally require a much larger team.

“We also had a dedicated technology team,

which, given the customisable nature of Stingray,

allowed us to adapt the engine to our needs.

STINGRAY

Stingray is a comprehensive new platform for

making 3D games that has grown from

Autodesk’s acquisition of the Bitsquid engine

Performanceiscritical,
especially ifyouwantto
release itonconsoles

PRICE: Monthly – $30, 1 year – $240, 2 year – $455, 
3 year – $650
 
USED FOR GAMES INCLUDING:
Warhammer: End Times– Vermintide, Helldivers

MINIMUM SPECS:

5 KEY FEATURES:

PROS:

CONS:

---------------------------------------------------------

MARTIN WAHLUND

CEO and co-founder 

Fatshark

www.fatsharkgames.com

---------------------------------------------------------

That’s almost necessary when you want to do 

certain optimisations that just can’t be done in a 

general-purpose engine. In general, it is easier to 

do optimisations when you know more about the 

game. You can make better assumptions on how 

things work so that you don’t need to cover every 

possible outcome, and you can focus only on the 

outcomes you know will occur in the actual 

game. Performance is critical, especially if you 

want to release your game on consoles. It doesn’t 

matter how good your game looks or how fun it is 

to play if it doesn’t run on your machine.”

Warhammer®: End 
Times – Vermintide™, 
image courtesy of 
Fatshark

BLENDER 
GAME ENGINE

Monument 

Valley

Swarm: 

Manchester

Aidy Burrows, game developer at 

vertSTRETCH, tells us how the engine 

uses a Logic Bricks system
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“Breakaway, Amazon Game Studios’ first title,

takes advantage of Lumberyard’s triple-A

performance and professional-grade tools,

running at 60fps with fully-deferred lighting, and

I enjoy using the engine’s vast selection of

rendering features to create our levels, such as

PBR rendering, voxel-based global illumination,

Substance Painter integration, vegetation and

foliage painting, and the Time of Day editor. Our

team leveraged Lumberyard’s sophisticated

character tools, Geppetto and Mannequin, to

create Breakaway’s rich selection of legendary

characters. Using these tools, our animators set

up real-time dynamic clothing and physics

attachments to bring them to life.

“One of our favourite features is Lumberyard’s

asset processor, which makes it fast to transition

AMAZON 
LUMBERYARD

Lumberyard is a free triple-A engine (no

revenue sharing, no subscriptions), deeply

integrated with AWS and Twitch

---------------------------------------------------------

ANDREW HARRINGTON

lead environment Artist 

Amazon Game Studios

games.amazon.com

---------------------------------------------------------

from Maya into the Lumberyard editor and then 

right into the game. We used Lumberyard’s 

Cinematic editor to build our in-game and 

marketing sequences that highlight our cast of 

characters. The editor’s intuitive tools provide 

real-time playback and timeline scrubbing to view 

the sequence, so we don’t have to wait for lengthy 

renders, making our iteration time insanely fast.”  

02 Save your height map Once your 

height map is baked out, create a TIF fi le 

using the Lumberyard Photoshop plugin that is 

installed when you set up Lumberyard. Place your 

height map in the alpha channel of your texture and

name your texture with the suffi  x _displ.

PARALLAX 
OCCLUSION 
MAPPING IN 
LUMBERYARD
The following steps are going to walk you 

through how to set up parallax occlusion 

mapping in Amazon’s game engine

01 Create the high-poly mesh The 

foundation of getting strong parallax 

occlusion mapping is a clean Height Map that 

showcases a wide range of depth and angles. 

Use a program such as ZBrush or Mudbox to 

create your high-poly mesh, which you will then

use to bake out your Height Map.

04 See your material in-game Create 

a simple plane and then apply your 

newly created material to it. Toggle on and off  

the Parallax Occlusion Mapping in the Shader 

Generation Params to see how it’s working and 

what needs to be adjusted.

05 Adjust Shader Params When 

Parallax Occlusion Mapping is toggled 

on it will expose new sliders under Shader 

Params. Adjust Height bias, POM Displacement 

and Self Shadow Strength to achieve a parallax 

setting that looks the best for your material.

03 Set up your material Open the Material 

Editor and create a new material. Under 

Texture Maps, plug in your Diff use, Normal Map 

and Specular textures. Place your _displ texture into 

the Heightmap slot. Under Shader Generation 

Params toggle on Parallax Occlusion Mapping.

PRICE: Free, with no seat licenses, royalties, or 
subscriptions required. Developers only pay standard 
AWS fees for the AWS services they choose to use
 
USED FOR GAMES INCLUDING:
Breakaway, New World, Crucible

MINIMUM SPECS: 

5 KEY FEATURES:

PROS:

CONS:

real-time. Instead it needs to be done in the modelling 
software and then exported





Create a realistic tiger 
beetle for real-time 
renderinginUnreal
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T
his tutorial covers techniques you can use to create a 

realistic tiger beetle that can be used in a real-time 

game engine. As virtual reality becomes more 

mainstream, the demand for artists that understand how to 

create textures for physically based shaders is going to 

increase dramatically. Game engines aren’t just for games 

any more. Game engines such as Unreal are used for virtual 

reality, real-time animatics, and it won’t belong before they 

make their way into fi lmmaking as well. This demonstration 

starts with sculpting the beetle model in ZBrush. Then you’ll 

learn how to prep the model in Maya and export for Unreal. 

You’ll learn how to use The Foundry’s MARI to build textures 

for PBR shaders and how to apply the textures to the model 

in Unreal. The huge advantage of rendering in Unreal is that 

once the materials are set up you can spend more time 

setting up the shot and less time – in fact, no time – worrying 

about rendering.

Discover how you can make your 
very own realistic tiger beetle 
using physically based rendering in 
Unreal Engine

Expert advice from industry professionals, taking you from concept to completion

All tutorial fi les can be downloaded from: fi lesilo.co.uk/3dartist
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01 Block out in Maya Start by blocking out the model in

Maya using Primitives. Establish the scale of the beetle 

parts using simple polygon geometry for the head, thorax, and 

abdomen. It’s not a bad idea to make the model a bit bigger 

than real life, since it can be tricky to work with very small 

objects in Unreal. Starting the block out in Maya ensures that 

the scale will be consistent as you import and export the 

between Maya, ZBrush and Unreal. Select the cubes and 

choose File>Export All. Save the exported model as an OBJ fi le.

02 Rough out the sculpt in ZBrush Import the OBJ 

fi le into ZBrush and activate DynaMesh to fuse the 

surfaces together. Use the sculpting tools to create rough 

shapes for the abdomen, thorax and head. Don’t worry about 

details or the legs. The DynaMesh phase is a rough sketch; the 

goal is to establish the relative scale of the primary forms. Using 

DynaMesh allows you to focus on the sculpt without worrying 

about topology. Once you are happy with the overall shape, 

split the head, thorax and abdomen into PolyGroups. Use 

Group Split to separate the PolyGroups into SubTools.

03 Sculpt fi ne details Use ZSpheres to create legs. 

Continue refi ning the parts of geometry. Split the 

model into SubTools for the head, antennae, each pair of legs, 

the hardened outer shell (known as elytra), the plates of the 

abdomen and the underside. Understanding the anatomy of 

the underside of the beetle is diffi  cult unless you have very 

good reference – this is where a microscope and a dead beetle 

come in handy! Once you feel like you have the basic shapes 

and details worked out, it’s time to retopologise the model.

04 Retopologise the SubTools It is extremely 

important to economise the number of polygons used 

in the fi nal game mesh since this model will be rendered in 

Unreal. Export high-resolution meshes for each part of the 

beetle, bring them into Maya and use the Quad Draw tool in 

the modelling toolkit to draw a new topology on top of the 

mesh. Use just enough polygons to describe the major forms. 

You will import the low-resolution meshes back into ZBrush, 

subdivide them, and then use Projection to project the detail 

from the original DynaMesh SubTool onto the imported 

topology. But fi rst you should create UVs!

01

DOWNLOADS
from fi lesilo.co.uk/3dartist

FREE
YOUR

ERIC KELLER
Tiger Beetle Rendered 
in the Unreal Game 
Engine, 2016

Software

Learn how to

02

03

04
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08

06 07

05 Lay out UVs in Maya It’s a good idea to create and 

lay out UV texture coordinates in Maya before you 

import the meshes back into ZBrush. The UVs determine how 

the textures will be mapped to the final game mesh. Organise 

the UV shells into three UDIMs – each UDIM corresponds to a 

4096x4096 pixel texture. Organise the shells so that the head, 

mouth, eyes and thorax are in one UDIM, the abdomen and 

elytra are in the second UDIM, and legs are in the third. Then 

export each individual mesh, import them into ZBrush, 

subdivide and project the details from the DynaMesh version 

to the imported meshes.

06 Export high and low-resolution versions of 
the mesh When you have imported all the new 

topology and gone through the process of projection you can 

delete the original DynaMeshed SubTools and save this as a 

new version. Keep your model organised by making sure you 

name the SubTools as well as the geometry in the Maya scene. 

Each part of the beetle should have clean topology and 

organised UVs. If you want to use an external software to bake 

normal maps you’ll need to export each part at the lowest 

subdivision level and a version at the highest subdivision level. 

Name these files ‘low’ and ‘high’ accordingly.

07 Bake Normal maps for the mesh There are 

many ways to create normal maps. You can use 

ZBrush’s Multi Map exporter to create normal maps for each 

SubTool. Using Multi Map exporter you can activate the Merge 

Maps and SubTools buttons so that the result is a normal map 

for each UDIM. ZBrush normal maps are pretty good. To really 

capture high-resolution details you can try using xNormal, or 

Maya Transfer Maps, or the baking feature within Substance 

Designer. All of these options require high and low-resolution 

versions of the model. Substance Designer creates extremely 

high-quality normal maps easily.

08 Start a MARI project In Maya select all of the 

geometry and choose Export Selected. Export an OBJ 

file entitled TigerBeetle.obj. This model will be automatically 

merged on export. Open MARI and start a new project and link 

to the exported merged mesh. Set the preferences so that the 

textures are 4096x4096. Set the location where MARI will 

export textures. You don’t have to add channels just yet – you 

can add them after the project has been created. Make sure 

Create Selection Sets is activated, as this will allow you to show 

or hide parts of the model while painting.

Master PolyGroups
ZBrush’s PolyGroup feature is a great tool for 

organising the mesh. PolyGroups play a big 

part in many of the more advanced ZBrush 

features. If you haven’t spent time practicing 

creating and re-arranging PolyGroups it’s 

worth the trouble. One feature that is quite 

useful is the Mask by PolyGroups slider found 

in the Automasking section of the Brush 

palette. The slider value determines how the 

brush affects the polygons in the surrounding 

PolyGroups. If you set the slider to 100 you’ll 

find it’s much easier to work on isolated 

portions of the mesh in the active SubTool.

05
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09

09 Create an Unreal shader in MARI From release 

3.1v3, MARI has an Unreal shader option that is 

designed to be compatible with Unreal PBR materials. Use the 

Create Shader menu to add an Unreal shader. Create the 

following channels and map the accordingly in the Unreal 

shader interface: color, roughness, metallic, specular, and 

normal. Use the Light panel in MARI to arrange the lights. If you 

have a spherically mapped HDRI image of a forest you can use 

this as an environment light to create realistic lighting for your 

tiger beetle. Setting up the lighting will make it easier to preview 

what the final shader will look like in Unreal.

10 Paint color maps using layers You’ll want to spend 

most of your time painting detailed color maps. Use the 

selection modes to isolate the various parts of the model based 

on the UV regions you imported from Maya. Keep your layers 

organised and take advantage of layer masks and groups to 

isolate the details on the various parts of the surface. 

Procedural noise layers are useful for breaking up the painted 

texture maps. Try adding a procedural noise layer and then set 

the Blend mode to Overlay. You’ll want to set the size of the 

noise to a small value and lower the opacity in order to create a 

nice, organic look.

11 Create metallic, roughness and specular maps 

The tiger beetle is a good example of a metallic insect. 

Many insects have this surface quality, including certain 

species of bees, flies and ants. The metallic map determines 

how much of the surface colour will appear in the specular 

highlights of the surface. Light values in the metallic channel 

mean that those parts of the surface will have more colour in 

the highlights, while darker colours will mean that the highlights 

will appear white or grey. For an authentic look, paint the 

metallic map in such a way that the head, thorax, abdomen and 

legs have light values and the eyes, mouthparts and elytra have 

darker colours.

12 Export maps from MARI Create a layer for the 

normal channel and import the normal maps that you 

baked earlier into the layer so that you can see the normal 

maps on the surface while you paint the beetle. Create simple 

organic maps in the specular channel to break up the highlights 

a bit. Now, paint a detailed roughness map. Dark values 

correspond to shinier parts, while light colours correspond with

duller parts. Think about which parts of the beetle will be dull 

versus which parts may be smooth and reflective. When you 

are satisfied with the look of the beetle, export each channel as 

a flattened PNG file.

10 11

Normal map editing
Normal maps capture the detail of a high-resolution 

mesh and transfer it to the low-resolution game mesh. 

They may be the most important type of map you’ll 

create for a game mesh. Creating normal maps with 

ZBrush is easy, but the resulting maps may need some 

editing in order to look good in Unreal. Use ZBrush to 

create the initial normal maps and then try using 

Substance Designer or xNormal to create high-quality 

normal maps for the most important parts (such as 

the head or thorax). Use Photoshop to combine the 

results into a superior normal map.

12
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13 Rig and pose the model in Maya Next, you’ll want 

to pose your beetle model and export the baked 

geometry as an FBX file. Build a simple joint rig and skin the 

pieces of the beetle to the joints. You can add hair using a Paint 

Effects brush and then convert the strokes into geometry. Once 

the geometry is posed, delete history and the rig. Select the 

geometry for each UDIM and create a simple Blinn shader. 

Name the shaders head_blinn, body_blinn and legs_blinn. 

Create a Blinn and apply it to the hair geometry as well. Select 

the geometry and choose File>Export Selection to Unreal. Save 

the file as an FBX.

14 Export the model from Maya and import into 
Unreal Typically you would export the model and 

skeleton, and sometimes even animated loops from Maya for 

import into Unreal. These would then be used to build 

interactive game assets. In this case, we are just focusing on 

practicing texturing and shading for Unreal, so you can go 

ahead and delete history on the geometry, delete the joint rig 

and the controls, select the geometry and use File>Export 

Selection to Unreal. Maya will automatically create an FBX file 

of the finalised model that is ready to be put into use in your 

Unreal project.

15 Create an Unreal project Unreal is game editing 

software that is free for artists to download and use. 

Download and install Unreal from www.unrealengine.com.  

Open the Epic Games Launcher and create a new project. Use 

a Blank Project with no starter content. In the Contents section 

of the browser, create folders for meshes, textures and 

materials. Organisation is absolutely key if you want to create a 

successful project. Make sure your files are named and in a 

location where they can be accessed easily. Don’t move the 

source files, as this can create broken links in your game that 

will cause big headaches later on. 

16 Import the meshes and textures Use the Import 

button to import the mesh and textures into the Unreal 

Editor. The Blinn shaders you applied to the different sections 

of the model will be imported with the FBX file. If you apply a 

different shader to each texture space in Maya before 

exporting, then assigning the materials you create in Unreal will 

be easier. Colour coding each region makes it easier to see the 

different UV texture regions in Unreal. If you have created hair 

using Paint Effects then you’ll need to make sure you have a 

Blinn material assigned to all the polygon hairs before importing 

them into Unreal.

Get natural props for your 
Unreal scene
There are a number of places where you can obtain 

organic models and textures for your Unreal natural 

environments. The Unreal marketplace has a large 

number of props and blueprints you can import into 

your scene to quickly create a forest scene. Some of 

these are even free! Quixel Megascans is a great 

source for high-quality scanned models and textures. 

Rocks, trees, grass, leaves and even mushrooms can 

add a lot of drama to your environment. The Quixel 

Megascans library has a selection of free samples you 

can download and try today.

15
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17 Create Unreal materials The textures you exported 

from MARI should be converted into PNG, JPG or TGA 

files before importing into Unreal. In Unreal, Ctrl/right-click in 

the Content section and choose to create a new material. 

Create a material for each texture region. Double-click on the 

material icon to open it up in the material editor.

18 Edit Unreal materials Within the material editor you 

can select nodes in the graph and edit their settings in 

the Detail panel below the preview window. To create a node, 

use the menu on the left, or Ctrl+right-click in the editor and 

choose a node from the list. Create Texture Sample nodes for 

each texture and connect them to the appropriate slot in the 

material. The material editor in Unreal is very powerful, and 

additional nodes can be used to adjust the textures or add 

special effects. Use the Details panel to choose the appropriate 

texture for each channel.

19 Import scenery and paint foliage To create 

scenery you can import props, such as tree stumps, 

rocks and plants. The foliage painting system in Unreal allows 

you to paint grass, weeds, ferns and other plants onto surfaces.

The Open World Demo Project is available for free on the 

Unreal Marketplace and it contains many plants that you can 

import and use in your scene as a foliage source. Drag the 

models onto the empty scene. Use the Scale, Rotate and 

Transform tools to place them. Use the menus in the Details 

panel to apply the materials to your objects.

20 Create a camera and adjust lighting Create 

cameras in Unreal to use for the final shot. You can 

add additional lights to simulate flash photography as well as 

adjust atmospheric effects and even lens flares. When you 

select the camera in the World Outliner a small window will 

appear in the lower right. Use this window to position the 

camera. Cameras in Unreal do a pretty good job simulating 

bokeh, bloom and exposure effects. Because all rendering is 

real time, you can spend more time on your composition and 

less time creating test renders.

17 20

18

19

Unreal Material 
Instances
Once you create a material in 

Unreal, Ctrl+right-click on the 

icon in the content browser and 

choose to create an instance of 

the material. In the Details panel 

for the beetle, use the Material 

menus to choose the instances. 

You can make many instances of 

the original material, allowing you 

to easily make variations for use 

on multiple objects. You can edit 

the settings of material instances 

without having to open the 

Material editor, which is very 

convenient in heavy scenes.
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C
G integration techniques with raw footage might seem

fairly straightforward at first glance, but as we go

further merging filmed footage with CG sequences,

you’ll see that the process becomes much more complex

than expected. The filming techniques that I am teaching

through this tutorial will be mainly focused on how to set up

the camera settings and CG object integration with raw

footage interpolating the foreground objects with the

background, but also I will teach the post-production steps in

terms of Curves adjustments, levels and lighting balance

between the CG geometry and footage.

Furthermore, it is important to make it clear that in this

tutorial I’ve used a short filmed sequence with a DSLR camera

to give an overview about how to apply these taught

techniques on any of your filmed sequences.

Undoubtedly, it is important to train your eye to allow you

to find the correct balance between lights and shadows, as

your own filmed sequences will likely differ from the specific

atmospheric conditions shown in this tutorial.

IntegrateCGinto
live-actionfootage
In this tutorial you will learn how to integrate CG geometry into a live-
action scene in After Effects and Element 3D

01 Set up the camera The camera settings are the

most important elements before filming a scene, as our

understanding of these parameters will enable you to learn

 INTEGRATE CG INTO LIVE-ACTION FOOTAGE

how to record a scene under different lighting conditions. This 

scene was recorded on a sunny day and for this one we should 

use similar parameters to the current image of reference. Set 

the ISO to 100, f-stop to 20 and Shutter Speed to 1/50.

02 Set the ISO ISO is used to detect more or less light 

according the ambient conditions, and this setting 

allows us to get a good exposure. If you’re taking shots on a 

sunny day, too much light runs through the sensor, which will 

cause overexposure. To make it less sensitive, use a low ISO 

number. Instead, darker conditions need a higher ISO, but this 

will cause noise in the image, so try to use the lowest ISO 

possible. In this scene we used ISO 100.

03 Define your f-stop The aperture setting controls 

the size of the lens opening, allowing the entry of light 

into the camera. Aperture affects the blur between the 

foreground and background, and using a low f-stop will create a 

shallow depth of field. Using a high f-stop will keep your photo 

sharp from the foreground through to the background (a wide 

depth of field). In the tutorial scene we used f22, because on 

sunny days outdoors we prefer to keep a sharper filming 

sequence, trying to avoid the foreground focus.

GUSTAVO ÅHLÉN
CG merged with 
footage, 2016

Software
After Effects, Element 3D

Learn how to

real footage

objects with footage

grading
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05

07

Histogram features
The camera histogram is a great feature to be used 

when you are recording videos or taking shots, as it 

shows the distribution of tones covering about four 

stops of dynamic range, from deep shadows on the 

left to bright highlights on the right. If you activate this 

feature, this will enable you to preserve all the tones 

without losing image information. When you get an 

underexposed or overexposed frame, you lose image 

information. If your image is badly exposed, it might 

look fi ne on the screen, but setting up your histogram 

will show you the true state of the image. Go online for 

for tutorials on understanding the histogram.

08

04

04 Understand shutter speed In photography, the 

shutter speed is the length of time for which the 

shutter is exposed to light. Fast values will freeze moving 

subjects and slow values will show the subject movement. A 

long exposure time is perfect for night-sky scenes where the 

light is low, and by using long exposure times we can capture 

the stars as well as light trails. Obviously, for night scenes this 

parameter should be compensated with a higher ISO setting. 

During daylight you’ll need to use a quicker shutter speed.

05 Set your frame rate We should understand that 

shutter speed in recording refers to the amount of 

time that each individual frame (frame rate) is exposed to light. 

If you set your camera’s shutter speed to 30, that means that 

each frame will be exposed for 1/30th of a second. Faster 

shutter speed values like 1/500sec will generate dark and crisp 

transitions and slower shutter speed values will generate 

smooth video transitions and more illuminated scenes.

06 Use a tripod for recording We opted for this 

short footage, mainly created to teach CG integration. 

Be sure to make use of a tripod in order to get good camera 

stability and to avoid shaky sequences. For this one, we used a 

50mm lens and a Canon DSLR camera. On sunny days we 

recommend an f-stop of between f20 and f18, but this 

parameter should be combined with an ISO 100 and a shutter 

speed of 1/50sec or faster. Combining the three parameters 

will be fi ne to start in recording your own sequence. By using 

higher f-stop values, we’ll avoid a shallow depth of fi eld and will 

therefore strike a balance between foreground and background.

07 Camera recording settings For this tutorial we set 

the camera’s ISO to 100, the f-stop to 20 and the 

shutter speed to 1/50sec exactly. On sunny days it’s easy to 

accidentally shoot overexposed images, so before recording 

don’t forget to activate Live View and the histogram. The 

histogram is useful for seeing all the image information. The 

footage has been recorded in a RAW sequence to be exported 

to After Eff ects, where we will merge it with CG objects.

08 Import footage in After Eff ects The sequence 

has been recorded in RAW and then it was imported 

into After Eff ects. For this, go to File>New Project, and in the 

Project panel, Ctrl/right-click>New Composition. In the Project 

panel, Ctrl/right-click>Import>File and pick the fi rst fi le and 

select Camera Raw Sequence. This will import all the fi les into 

a single one. Drag the footage fi le to the Composition panel.

06
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Cinestyle profi le
Sometimes we can record videos using the standard 

camera profi le, but if you want to enhance your 

recording sequences to be correctly graded in 

post-production – keeping the dynamic colour range in 

dark lighting conditions – we recommend installing 

Technicolor Cinestyle Profi le for Canon cameras. This 

process will retain the details in the light and dark 

areas, which is great for colour grading, Curves 

adjustments and any other post-production process. If 

you want to fi nd more information about how to install 

this colour profi le in your DSLR camera, just go to 

www.technicolor.com and search for Cinestyle.

09 Add the CG object Ctrl+right-click on the 

Composition panel and create a solid layer. Go to 

Eff ect Panel>Video Copilot>Element 3D. Click Scene Setup, 

and I used a Video Copilot package (Jet_Strike), selecting 

Supersonic_Jet_02. In the body material, change the Specular 

Value to 1.96 and the Fresnel Refl ection to 0.78 in the glass 

material. These values will depend on your scene, but they 

work well for this tutorial scene. Go to the Eff ect 

Panel>Element>Group 1>Group Utility and Create Group Null. 

This Null will work by staying linked with the object.

10 Record keyframe transitions The keyframe 

transitions will record the position, angle and size of the 

object. Drag and drop the timeline to 00:00 and click on the 

small arrow on Group Null 1. Then, click on the small clock of 

Position using the parameters (-48, 540.0 ,-811) and click on 

the small clock of Z Rotation. Now, drag and drop the timeline 

to the last frame – 00:09 – and change the parameters of 

Position to (-48, 540, 15000) and Z Rotation to (0x-50).

11 Add a new camera It is time to add a new camera in 

the scene. To create a new camera, Ctrl+right-click on 

Composition then go to New>New camera. The camera is 

perfect for creating depth of fi eld, allowing us to blur the CG 

object from a certain distance. This blur will be determined by 

the Focus Distance and Aperture parameters. Set the Focus 

Distance to 2666 and the Aperture to 7.8.

12 Include ambient and sun lighting Now we need to 

add the ambient and sun lights to the scene. The 

ambient light is perfect to equilibrate the direct light to the 

object. This should be added before the sun. Ctrl+right-click on 

the Composition panel, select New>Light and choose Ambient 

with its Intensity set to 50%. Try to select a blue-ish colour and 

add a new one, this time choosing Point. Choose an orange 

colour with an intensity of 1500% and choose Cast Shadows.

13 Add a Noise adjustment layer Create a new 

adjustment layer. Ctrl+right-click on the Composition 

panel>New>Adjustment Layer. Go to Eff ect Panel>Noise & 

Grain>Add Grain. This layer will be applied over the layers 

below. If you want to apply an adjustment layer over a specifi c 

layer, you’ll need to create a separate composition. Go to 

Viewing Mode>Preview. This option will enable us to get a 

preview of the fi nal grain. I used the Kodak SFX 200T preset 

with an Intensity of 0.3. To apply it to the whole image, change 

the Viewing mode to Final Output.

09

11 12

13

10
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Gustavo Åhlén
Gustavo Åhlén is the founder of Svelthe, a business

dedicated to creating concept art, motion graphics,

animation for games, commercials and films. For

some years I have specialised in human anatomy as

well as traditional arts, and after improvingmy skills

in these areas I began in the CGworld.

CG Particles Experiment 01,2016
After Effects, Cinema 4D, Trapcode Form
This image was made as a personal particles experiment

where the base mesh was done in Cinema 4D and exported

to After Effects where a Trapcode Form effect was added.

CG Trapcode experiment,2016
After Effects, Trapcode Particular
This is a frame of some motion graphics work that has been

done using After Effects and Trapcode Particular. To

enhance the light trails, Trapcode Shine was added.

CG Particles Experiment 02, 2016
After Eff ects, Cinema 4D, Trapcode Form
This was also made as a personal particles experiment. 

Once again I created the base mesh in Cinema 4D before 

exporting to After Eff ects.

14 Add a Color Grading adjustment layer Colour grading is the perfect way to blend 

images with diff erent colour tones. In this case, it’s perfect to blend the background with 

the CG object in the foreground. Create a new adjustment layer and rename it so you know 

which layer it is. Go to the Eff ect panel and Ctrl+right-click>Utility>Apply Color LUT. In this 

tutorial I used M31 – Rec.709_32 and by going to Layer>Transform>Opacity you can control the 

intensity of this colour grading. If you consider it necessary, you can create a new adjustment 

layer and add Color Correction>Levels, but in this particular sequence it didn’t seem necessary.

15 Prepare your render settings To render the fi nal composition, go to Composition> 

Add To Render Queue or Add To Adobe Media Encoder Queue. For this tutorial I used the 

native renderer in AE and it can be confi gured by going to the Render Queue panel and keeping 

the default values, but changing the Output Module to Format (QuickTime) with H.264 video 

codec. Then, click on Output To and save the render fi le into a folder in your computer. Then, 

click on Render, and that is all!

14

15

Motion tracking 
a camera
If your scene has diff erent 

planes and you are fi lming 

using the panning or tilting 

techniques by moving the 

camera, you can use motion 

tracking to adapt the CG 

objects over the diff erent 

axis planes. For example, if 

your scene has a ground 

where you want to add an 

object resting on the fl oor 

and the camera changes the 

focus angle, it is really 

important to add an eff ect 

over the video layer named 

Motion Tracking. This 

process will analyse your 

image, looking for points to 

follow and turning your video 

footage into a 3D scene.
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T
his tutorial will go over some of the basics of using 

Hard Ops for modelling and rendering. In addition we 

will also go over some traditional modelling techniques

and look at how they can be used in conjunction with Hard 

Ops for rapid hard-surface concepting. The purpose of the 

tools is for concept mesh generation and making the most of 

functions that Blender excels at. Hard Ops also is capable of 

hard-surface smoothing and effi  ciently managing modifi ers in

addition to providing several helpers to speed up the process.

The red insert system will also be used to make short work of

detailing and finalising the model.

Master Hard Ops 
for Blender
In the future, scenes always have kiosks as a way of showcasing futuristic 
computers for public use for a number of purposes

JERRY PERKINS
Your First Kiosk, 2016

Software
Blender

Learn how to

and the Q menu options

sharpeners

Project

Concept
No concepting done for this 

practice for myself so usually I 
just build a shape and get to 
work on it. 

 Block in the base form of the kiosk Starting with 

the default cube, begin doing some extrusion and start 

shaping the base form of the kiosk. You will be able to work 

rather loosely thanks to Clean Mesh (Q>Meshtools>Clean 

Mesh), which allows you to simplify the mesh to the simplest 

planar forms and then add more detail when needed.

 Enter Csharpen Csharpen is one of the main 

options from the Q menu. This option will basically 

give the mesh hard-surface smoothing in addition to applying 

certain modifi ers and adding a bevel modifi er on top. The bevel 

modifi er will be present for the remainder of the tutorial and 

will play a role in surfacing the kiosk and adding some 

smoothing to the edges. Once the Csharpen has been used, the 

Q menu will have an option called B-Width, which can be used 

to adjust the bevel width of the bevel modifi er without needing 

the modifi er panel.

02

 Enter Demote As the model becomes more and 

more refi ned, you can use edit mode operations that 

will allow you to adjust the bevel being applied on the object 

level, and even Demote edges to being just sharp and not 

bevelled so that they can then be bevelled manually using 

Ctrl+B. This step will be used quite a bit in cases where you 

need a bevel larger than the modifi er in a specifi c area or to 

resolve pole-based bevelling issues.

03

01
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04 Enter Cslice Cslice was created as an alternative to 

rebool for times when you want to cut fi rst and ask 

questions later. In this example, a plane was added and 

extruded and then the base form was selected and Q>Cslice 

was chosen. This can also be accessed with the shortcut Ctrl+*. 

After the cut the pieces are separated, they can be detailed 

individually or given different bevel levels.

62 

Managing tricky geometry
While the clean mesh can work with simple objects to 

simplify surfaces, it is not recommended on refi ned 

pieces, as you may lose the detail that was intended. 

When it comes to mesh control, the shortcut 

Ctrl+X>Dissolve is useful for dissolving troublesome 

edges that can be created when using Boolean>Carve. 

Also, G>G brings up edge slide, which can be useful for 

moving edges away from each other. Another useful 

shortcut is Alt+X Symmetrize, which can be set up in 

the Q menu. When the Symmetrize operation is done, 

there will be edges in the centre that can be bevelled to 

create linear edge fl ows on ngon meshes easily.

05 Fun with the Knife The Knife tool can be used in 

situations where detailing needs to be applied to the 

surface and handled diff erently. This technique comes in handy 

when the surface form needs to be honoured while layering a 

cut on top and you want to handle this process in steps. After 

cutting this shape in and tweaking it, the selection can be inset 

by pressing I and then pushed in on the normals with Alt+S. 

After doing that, the loop that surrounds it is sharpened, which 

helps to integrate the modelling.

06 Detailing with inserts Hard Ops contains some 

custom-made inserts that can be used to quickly 

detail areas where it is needed. The inserts that have the letter 

A are adjustable, while the red border means that these inserts

are meant to be inserted below the surface. The moment one is

placed, hold Ctrl to adjust the location of where it was placed 

via face snapping. The insert will also automatically select what 

is called the adjustment plane so that it can be placed 

effi  ciently for application.

04

05

06



07Using the 2D Bevel For 2D shapes, a new bevel

operator has been added into Hard Ops 8 called 2D

bevel, under Operations. This will allow you to simplify the

mesh and the bevel on the vertices. However, this will not work

well on a 3D shape. In this instance, the 2D bevel was used and

then solidified using T-Thick in order to boolean join using

Ctrl+‘+’ and create the nested screen. Copy the 2D shape to the

clipboard using Ctrl+C so that it can be pasted later using

Ctrl+V for additional cutting.

Cslice was created as an
alternative to rebool for times when

you want to cut first and ask
questions later

63

07

08 Hard Ops and Booleans In this example, a cube 

was inserted and then booleaned into the main shape 

using Ctrl+‘-’. After this step, that same shape can be selected 

and a special Q menu will be available for boolean shapes. By 

using the special B-Width here, the shape can be bevelled 

without aff ecting the bevel crease information of the main 

form. When completed, you will also be able to select the main 

form and go to Q>rebool to get the opposite shape of the 

pending boolean modifi er.

09 Using Mirror Mirror When it comes to mirroring 

there are a series of solutions available in Hard Ops. 

Symmetrize will mirror something destructively on a particular 

axis and be done. Mirroring will add modifi ers and be kept live 

until you apply them or remove them. On the main body, use 

Symmetrize on elements that join at the centre of the X axis. If 

the object is on the other side of the X axis with no connection 

to the centre, use Mirror Mirror. That way you will be able to 

adjust one side while the other updates automatically and there 

is less need for Symmetrize. While they diff er, their main uses 

are destructive and non-destructive symmetry.

08

09
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10

12

12 Create a base for the base If you were to insert a 

cylinder it would have 32 spans. If you also hit Ctrl+2 to 

subdivide it, the mesh would look like a disaster. With Hard 

Ops, just press Q>Ssharpen to harden and crease the sharp 

edges, allowing you to quickly up-res a cylinder as you are 

working. Hard Ops has a pop-up modifi er helper that you can 

access with Ctrl+‘~’, which can be useful for applying modifi ers 

and adding them without cluttering up the workspace.

11 A Kiosk needs a place to stand With a simple plane 

and W>Subdivide a couple of times, you can add some 

additional geo. With all faces selected, use Q>Meshtools>Face 

(Grate) and turn the faces into rotated grates. This was one of 

the fi rst features added to Hard Ops. The next step is creating a 

curve circle and using that with the Knife to cut out a circular 

area of the geometry. Press P to separate the geometry that is 

selected after this operation, and then delete the exterior.

10 Insert Mania Part 2 At this point, inserts are your 

best friend for adding additional details without 

additional work. Usually it helps to cut and separate complex 

areas that are being detailed to prevent the system from 

slowing down. Csharpen can get slow as you insert more and 

more. It’s also worth explaining the merge options. When the 

insert and underlying mesh is selected, you have an option to 

merge it completely, or merge it but still be able to adjust it and 

duplicate the insert set. These can come in handy for placing 

the same insert in multiple places.

11

 Boolean cuts and rebool are 
used to quickly add some detail 
to the base just to make it look 

less boring  

Managing inserts 
and mesh madness
New users are bound to boolean 

themselves into trouble when 

fi rst getting started, especially 

with the rounder inserts. When 

corners are bevelled, it will 

almost certainly cause some 

issues with more edges being 

created than desired. Booleans 

can be controlled quite well with 

guidance loops being placed via 

the Knife in order to limit the 

amount of new geometry that is 

being created.
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13

14

14 Shade the scene using the material menu
Alt+M in Object mode brings up the material menu for

assigning materials based on materials present in the scene.

This can also be done via the Ctrl+‘~’ material helper tab. In the

example here, you can also see the duplicate materials created

by the inserts being duplicated. These will be replaced on the

next reopening of the file.

15 Creating a lighting half sphere With another plane

subdivided, inset it by pressing I twice and then pressing

P to separate the mesh that was inset. The borders will then be

deleted. Ctrl+‘~’ brings up the modifier helper that can be used

to add a cast modifier of a sphere with a factor of 1. After

moving the object away in Edit mode, the object will be 

deformed spherically, and this can be used to provide a rim light 

for the image. Also, under Q>Settings>Wire Mode there is an 

option to make the light felt but not seen by allowing only the 

ray visibility for diff use and glossy shaders and not camera, 

therefore making it invisible.

Material cleanup for inserts
At this moment in time all the inserts you’ve inserted 

will have created their own materials. To resolve this, 

use Q>Operations>Material Link to fi x it. However, 

there is also the option to replace all the main materials 

on the fi rst inserted object then replace the material 

IDs on all objects with those materials using 

Ctrl+L>Materials. Unused materials will be purged out 

of Blender with a close or reopen, or using the revert 

option under the File menu after saving.

15

13 Detail the base Boolean cuts and rebool are used to 

quickly add some detail to the base just to make it look 

less boring. Cutting a shape like the one in the image for this 

step seems like a natural fi t for Booleans, but Knife Project is a 

much better choice. When the mesh is non-manifold, 

sometimes you have to change up the workfl ow in order to 

accommodate this without issue. Knife Project has many uses, 

and it’s one of my favourite cutters in Blender.
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16

16 Set the stage by making one The stage is just a bevelled plane that sits underneath 

and emulates studio lighting. Another useful tip is that under the select menu you’ll fi nd 

Select Boundary Loop. Get this mapped to Shift+‘~’ in Edit mode. With this shortcut set you can 

just make the plane, bevel it and then select all with Shift+‘~’ and use Q>Make Ssharp to allow 

you to also subdivide the shape for additional smoothness, since the edges are creased.

17 Setting up a 360 turntable render For the fi nale, insert a curve. Then select all the 

lights plus the backstage and, fi nally, select the curve. Use Ctrl+P>Parent (keep 

transformation). In the transformation box for Z, put in the following command: #frame*0.15. 

This will rotate the circle’s every frame according to a driver that is created when using that 

function. You are also able to click and adjust the number to increase/decrease the speed.

H6, 2016
Blender, OctaneRender
Robots and helmets are a passion of mine and these two are

just one of many designs I’ve made over the course of testing

Hard Ops.

Hard Ops Time, 2016 
Blender
Hard Ops was being tested to the max in the making of this 

timely piece. For a moment I was considering this one as the 

topic for the article you’re reading now.

Deux V3, 2015 
Blender, Photoshop
Deux is my personal mascot and is representative of my 

current skill and technique. He is reborn over and over using 

better and better techniques.

Jerry Perkins
I am a self-taught 3D artist who started out in Blender. I 

have a YouTube channel with over 400 videos and am 

a Blender Foundation certifi ed trainer.

17
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Techniques

A beginner’s guide to
procedural shading
P

rocedural shading is something that can become an

incredibly useful skill to learn, as it can allow you to

generate reusable assets, which can come in handy in

larger projects. The skills it requires can also help when

shading actual textured assets since it gives you the

understanding of shading attributes you need in order to add

that extra bit of realism to what you make. This tutorial will

cover a very basic material creation process as well as some

extra bits of helpful information that should hopefully give you

an understanding of the foundations of what you will need to

begin procedurally shading your own assets. I will be using

V-Ray 3.1 and Maya 2016, but much of what I show you will

be applicable to many other renderers.

Also, I heavily recommend Grant Warwick’s ‘Mastering

V-Ray’ series, as his videos are incredibly informative –

however he works exclusively in 3ds Max in his videos. I

figured I could do a little translating for you guys to help you

learn the basics!

So first of all, why should you use a procedural approach?

Procedural shaders within Maya have a multitude of uses.

The primary advantage of procedural work is how easy it is to

re-use shaders on different projects or multiple objects in one

scene, and they are incredibly quick to create iterations with.

Using procedural shaders allows you to test lots of ideas

quickly before you take the time to paint a final version of all

the texture maps. Finally, if you have any difficulties in any

steps of this tutorial, please feel free to contact me or see a

previous tutorial I wrote on my website which spends longer

explaining the initial concepts and nodes.

Michael is a 3D artist
based in Bournemouth,
specialising in the
areas of modelling
and shading

Michael Cauchi
mikecauchiart.com

Maya

Matthias is a 3D artist
at MachineGames. He
has a burning passion 
for hard surfaces and 
anything tech related

Matthias Develtere
develterematthias.wordpress.com

MODO

Our experts
The best artists from 
around the world reveal 
specific CG techniques

MAYA

DOWNLOADS
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FREE
YOUR

freelance in animation,
3D applications and

Mike D McCallum
reallusion.com

iClone, Unity

01 Break it down When approaching the creation of a 

procedural shader you must fi rst break down what 

makes that material. If you wanted to create a painted wood or 

metal, for example, it would be very diffi  cult to capture all the 

eff ects within one material. Instead, try creating several 

materials (one for each element) and put them all together 

using a Blend material (such as ‘vrayBlendmtl’) and use the 

Blend Amount to defi ne where that element is visible. In this 

tutorial we will make a painted metal, so we need a metal, paint 

and test material.

02 Create your base material So to get started 

creating our shader we will create our metal material. 

First, create a vrayMTL node in your Hypershade and name it 

something like ‘Lead_Mtl’ (keep naming conventions clear as 

this will be helpful later). If you don’t know, most metals have 

little to no diff use component so you’ll want to set that to black 

(since it’s this black diff use that gives metals their distinctive 

look). You’ll then want to set your refl ection values based on 

your reference, but make sure that the Refractive IOR is set to 

1.9 as this is the IOR for lead in reality.  

03 
Add variation There is no such thing as a perfect 

surface – this means that to create a truly convincing 

shader you need to add subtle variations to the surface. From 

my experience I’ve found that this is easiest to achieve using 

the gloss and bump attributes, as these combined can simulate 

scratches, dirt, dust, grease or anything else you may want. Try 

to keep the variation subtle, though, because if any of these 
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effects are pushed too far then it will destroy any chances of 

your end result feeling real. Once you’ve achieved a realistic 

final result, you’ll want to plug this material into the Base 

Material attribute of your vrayBlendMtl that you created in the 

previous step. 

04 Create your secondary materials Now it is time 

to create our other materials. In this case these will be 

paint and dust, which we will create using the exact same 

methods we used for creating our initial base material. As a 

general guideline, I had my paint diffuse set to green with a 

Reflection Gloss value of 0.6, but feel free to set the material as 

you wish. Shading the dust was more interesting since it has a 

very particular look with its Fresnel, which is much easier to 

replicate with a Sampler Info node. Be sure to plug these 

materials into the coat materials of your vrayBlendMtl.

05 Sampler Info for custom effects The Sampler 

Info node is a fantastic way to create many different 

effects for your shaders because it allows you to use any 

information gathered by the sampler at render time to modify 

your material. For example, you can use the Facing Ratio 

(normal angle) as the UV coordinates of a ramp to create your 

own Fresnel curve, but it can do much more than just this. 

When it is combined with the setRange node (which remaps 

values from the Sampler Info to be able to be used for a ramp) 

you can use any world-space or object-space attribute to drive 

your materials.

Keep it real! 
One aspect of shading that I see is most often 

overlooked is the Refractive/Fresnel IOR values. The 

index of refraction is a material quality that dictates 

how light interacts with the surface/volume of that 

object based on viewing angle (normal angle). The 

default value is 1.6, which gives a slightly plastic feel to 

many materials.

The best resource that I can recommend is  

www.refractiveindex.info as it has everything laid out 

very clearly and even has a 3D shelf dedicated to 

helping us 3D artists along by giving us values for 

common materials.

0501 

02 03 
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Always check your 
channel numbers 
It’s always important to know which 

and how many channels you are using. 

Most material attributes use all RGB 

colours, even if the eff ect you are trying 

to drive is monochromatic by averaging 

their values. Except for some attributes 

like refl ection, glossiness can only take 

one channel – by default, when 

dragging a texture onto this attribute 

Maya will connect the alpha channel of 

your texture as it is a single channel 

output. However, by default the alpha 

is often a fl at white colour, which 

results in polished materials. It is 

sometimes best just to connect a single 

channel of your RGB instead!

06 Create your test material Since this shader 

workfl ow relies heavily on the use of masks, it is very 

important that we can see exactly what the mask is doing. The 

easiest way to do this is to use a V-Ray Light material –

vrayLightMtl – and plug your mask into the Color slot. The 

reason that we use this instead of a vrayMtl is because the 

V-Ray Light material doesn’t receive shadows or highlights, 

which could easily interfere with what you think your mask is 

doing, and what you see on the colour is truly representative of 

the actual mask.

07 Create the material mask Since the values on the 

map are what defi ne the mask strength, it’s best that 

you keep the mask monochromatic in order to make it easier to 

visually judge the strength. Since we want to be able to re-use 

our shader on multiple objects, we will be using procedural 

nodes to generate the map. Try using the V-Ray Dirt and 

Curvature nodes to generate a mask based on your geometry 

and combine those with fractals to break up the evenness of 

the mask by plugging it into attributes such as the V-Ray Dirt 

Radius setting.

08 Add some dirt The last thing that I like to add to 

many of my shaders is some kind of dirt. The type of 

dirt you add depends on what you are making, where it will be 

used and how old it is, as this adds an extra layer of realism. For 

this shader I will be adding a simple dust on any top-facing 

surface or occluded areas to make the shader feel old. First, 

make a Dirt material using the same process as earlier. Then, 

try combining a V-Ray Dirt and a Snow node to create a mask 

for this material.

09 Final touches Now that everything is in place, it’s 

time to add those fi nal touches to really sell the 

realism or simply to polish what you already have. In the case 

of this shader I decided to attach the paint mask we generated 

into the Displacement, which results in giving the paint an 

actual thickness. You could also try adding some extra Bump 

details using tileables (or even some hand-painted maps for 

the most control, which is what I would recommend if you’re 

making a hero asset) for scuff s and scratches, since it’s very 

diffi  cult to generate such eff ects using only Maya nodes.

07

09

08
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Speed model a game
asset in MODO
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from fi lesilo.co.uk/3dartist

FREE
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I
n this tutorial we will go over how to design a model in 

roughly six hours. These are just some quick guidelines on 

how not to get bogged down with a big game asset. In this 

industry you don’t always have the luxury of a concept, nor do 

you have too much time to spend on your work, so here we 

will use some quick techniques to get our design done fast.

We will be using MODO to show some quick prototyping 

hints and tips. These are exclusive features for MODO. For 

rendering we will use some unique features from KeyShot, 

before wrapping up with some post-production steps and 

general tips and tricks.

This tutorial comes with two extra videos showing how to 

make a quick render in KeyShot. For those who want to see 

some alternative methods, check out Tor Frick’s sci-fi  

transport vehicle tutorial on Gumroad.

01 Photobash a blueprint First of all, there is nothing 

wrong with photobashing from photos or even designs 

– it gets done in the industry all the time. Let’s do this for our 

gun, by just searching for interesting designs on ArtStation and 

real reference pictures on Prime Portal. Note that these images 

don’t have to be side views from the start, you can just warp 

them later. This should not be a beauty render, just a rough 

blueprint idea. Perspective doesn’t matter at all at this point. To 

make the reading easier, put a desaturation level on the layers 

and work with levels that match photos with one another.

02 Use Round Edge Shader P1 This is the strongest 

feature of MODO for prototyping. The main idea is 

that you can shove shapes into each other and blend them 

together. You can tweak the blend radius yourself. Note that 

MODO
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Key pointers for post-production
There’s is no solid set of rules for post-production. There 

is always a lot of experimenting involved, but I have 

some methods that I always come back to. Tweaking the 

red, blue and green channels separately from one 

another is one of these – that way you get more control 

over the final look.

Using my AO as a mask for spec and reflection is 

another – you don’t have reflections in shadowy places. 

Use a metal pass as an overlay for some pieces, so you 

can make the difference between the materials stand 

out even more. Don’t go too noisy in your background 

either – if your design and render is good, then a flat 

colour or gradient should be enough for presentation.

04

01

05

using angles that are too extreme can break the blend. It’s 

reliable, but don’t expect miracles from it. To use the shader, 

the models understandably have to share the same material. 

For example: a fabric will never blend with steel, and a steel 

surface will never blend with copper. 

03 
Find the shader Setting the shader up is really 

simple. Press M (material), name it something relevant 

(Metal Smooth 1 cm, for example), and assign it to your 

models. After this, navigate to the shading tab, click on the 

Material folder and then the material inside of it.

Now, let’s go into Properties, which can be found underneath 

the shading list. Go to the Surface Normal drop-down menu, 

and head to the last line. There you should see Rounded Edge 

Width. This is where you change the steepness of the blend, 

and where the magic will happen. 

04 Make test renders The start value is always set to 

0 metres, but metres are way too big. It’s fine if you 

work with full-scale models (with ‘human’ measurements in 

mind), but most of the time we can stick to something around 

one centimetre. What you will see when using this feature is 

that it doesn’t do anything in the viewport. It only displays your 

blending in the Render tab of MODO. This will take some time 

to get used to, as there tends to be a lot of back and forth 

between the Render and Model tabs.

05 Start experimenting Now that we have a hacked 

together a sketch, we can start experimenting to 

mimic the shapes. A lot of people presume that a side view 

sketch alone is not enough information to start working with, 

but often it gives you an opportunity to use your imagination to 

fill in the blanks and come up with your own interpretation. 

Avoid getting stuck in side view, however; it’s a 3D model, not a 

2D model. Try to add some bulky, smooth and round shapes to 

your model too. That way it will catch some really interesting 

lighting, and you can blend them in with the shader as well.
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06 Make use of floaters and decals A quick way to 

avoid wasting time is to use floaters and decals. That 

way you can quickly add a detail pass to your model without 

having to model the details into your mesh. Just put a nice extra 

polygon loop around the model so that when you add a SubD, it 

blends nicely into the main shape. Of course it will still be 

noticeable from some angles, but in most cases you can just 

change the camera angle or fix it in Photoshop. The same goes 

for decals – just stick them against the model. You can always 

apply a bend modifier so the characters or images follow the 

same flow.

07 Explore box mapping and tiling If you unwrap it 

the traditional way you have to do it as a 3D model 

package, straighten everything out and pack it really nicely, but 

that takes a lot of work. I personally never unwrap my 

high-poly, I just rely on the Box map tool in KeyShot. It’s just 

one button with a few sliders for size, rotation and angles. It’s 

not perfect, and it can create some ugly seams, but by using 

tileable layers it shouldn’t be that noticeable. The scale slider 

lets you change the size of the texture – you just want to be 

sure people don’t notice the pattern, so don’t set it too high.

08 Blend your layers You can create some tiling 

textures with Quixel and save them as PNGs (it’s best

to just save all the individual layers as PNG files so you can use 

them as masks in KeyShot). Making one tileable texture is nice,

but combining them is really interesting. Just think about real 

materials – everything is built out of layers.

For example, start first with a bare metal, then add a base 

coat, paint primer, dried-up dirt and then fresh mud. Another 

thing we can do here is duplicate a material multiple times, 

rotate the copies separately and then blend them with the 

intensity and contrast sliders. This will help break up the tiled 

feeling of your model.

09 Manage post-production and colour changes
Post-production is so important. Just look at the 

difference in the two images highlighted. I always render out 

high-poly with high contrast colour. I always render out a metal

pass, AO and a depth pass. You can use your ambient 

occlusion as a mask for cavity information. You can even 

combine different AO with different colours to get some nice 

looks. Something that also helps is having an incoming light, as 

in the example, so you get the feeling that is there is something 

happening around the model. Adding this light from the bottom

is a good idea.

08

All tutorial files can be downloaded from: filesilo.co.uk/3dartist

09

Using the colour wheel 
The colour wheel is a really powerful tool, both for lighting 

and materials. Versions of it can be found everywhere on 

the internet. The idea is simple, you just pick one colour 

and go to the opposite side of the wheel to find another 

colour. These are extremes of course, but these 

complementary colours work really well together – all my 

designs use them. Orange works with blue, green with 

red – most of the time I use one as the main colour and 

the other as an accent colour, or use one as a main 

material and the other one as an incoming colour. 

Whatever your approach, complementary colours will 

make your model stand out more.

06 07
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Create VR content using
iClone and Unity
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FREE
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01 Lay out the scene Inside iClone, choose content that

will work for your VR project. For this tutorial we are 

using the included lounge scene that comes with iClone. Add 

additional models like plants or other furnishings from the 

library, or import any FBX, 3DS or OBJ model to add to the 

scene layout. iClone helps to layout and also previsualise 

everything before you go to the game engine. 

B
eyond science fiction, virtual reality enables you to

immerse yourself into new worlds using a variety of VR

equipment and software that can make the modern-day

holodeck a reality.

Learning the process of creating VR-ready content isn’t just

for triple-A studios, as tools and hardware are readily

available to make VR creation possible for anyone with some

imagination and a little bravery. I’ve found a way to quickly

generate characters and environments for VR using

Reallusion’s iClone and Unity 3D – and without the need to

write a single line of code.

Thanks to free utilities from Oculus and HTC, we can drag

and drop our way onto a viewable VR platform in minutes,

and that’s with navigation – possibly even multiple sources of

navigation. Making your own VR gallery to walk around is 

within easy reach if you have 3D modeling skills or know 

someone that does. To do this we will need a few things: your 

HMD of choice (Vive or Rift), iClone 6.5, 3DXchange 6.5, 

Unity 3D, SteamVR (Offi  cial Toolset), SteamVR Unity Toolkit 

and Oculus Utilities (Offi  cial Toolset).

ICLONE, UNITY

Setting up the props and characters for your VR project is 

quick work with the right tools. iClone is a real-time 3D 

software from Reallusion that has a pipeline that works with 

Unity and Unreal Engine. 

For this tutorial we will send all the models to Unity, but 

fi rst we need to source our props and characters. If you are a 

character modeller or can bust out some quick props in 3D, 

then you are ahead of the game.

If you you need access to 3D models and characters, then 

iClone has a some free solutions and also a 3D model 

marketplace that can get your VR environments full of 

content in a matter of minutes.
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02Prepare to export iClone content can be exported 

to Unity or Unreal using 3DXchange, which is part of 

the iClone Animation Pipeline. To export the iClone props 

(characters are covered later in the tutorial), select the props 

that you want to export and use from the Scene panel on the 

left. Shift+click to select multiple models. Use the Pick Parent 

option in the Modify panel on the right to select an object to 

parent all the props. You can use a dummy prop for this or 

select a model in the scene to act as the parent model. 

03 
Send to 3DXchange Now that you have parented 

all the props you want to use in your VR project from 

the iClone scene, it’s time to send everything to 3DXchange. 

This process will prepare your content to be ready for Unity and

set it up so that all the models will export as you saw them and 

arrive in Unity with the same layout. Select the chosen parent 

model as seen in the screenshot. We have parented everything 

to the ceiling prop. From the Modify panel on the right, select 

Edit in 3DXchange to export your props from iClone.

04 Prepare FBX for Unity The props all load into 

3DXchange with the same layout as in iClone and will 

remain this way when imported into Unity. All models are still 

accessible individually, as seen in the scene-tree hierarchy on 

the left side of the 3DXchange window.

05 Export Unity-ready FBX 3DXchange has been 

fine-tuned to format the FBX files to work well with 

Unity and other platforms. The FBX Export menu gives many 

options to customise the FBX file, as well as a number of preset 

options that automatically set up FBX properly depending on 

your intended destination for the FBX file. Unity is one of those 

presets from 3DXchange.

 Creating VR content isn’t just for
triple-A studios, as tools are available
to make VR possible for anyone  

04
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06 Oculus Rift in Unity Begin a new scene in Unity 

and add the Oculus Utilities Toolset. Go to Game 

Object>3D Object>Cube. Make the cube 50x1x50 or whatever

fits your individual needs, as this will be for the content to sit 

upon. Oculus Rift uses an Xbox controller that makes creating 

the platform with navigation a very simple process of dragging 

and dropping one tool from the Oculus Utilities toolset. Locate 

the FBX file exported from 3DXchange and drag it into your 

Assets and then on to the stage. Delete the main camera and 

from the OVR>Prefabs folder of the Oculus Utilities drag and 

drop OVRPlayerController. This replaces the Main Camera and

becomes the player too. It also has Xbox controller navigation 

built in!

07 HTC Vive in Unity with VRTK The Vive relies on 

the free SteamVR plugin from the Asset Store even if 

you are using the camera rig from the open-sourced Steam VR 

Unity Toolkit. Start this platform off the same was as we did 

with the Rift. Open a new project in Unity. Use the Asset Store 

tab to navigate to the free SteamVR plugin and download it. 

The free VRTK is also suggested for ease of use and a quick 

start. Search for VRTK in the Asset Store and import it into the 

project. Delete the main camera in the Unity Hierarchy tab. 

Drag and drop the SteamVR Prefab into the Hierarchy tab. 

Then, drag and drop the CameraRig from the SteamVR Prefabs 

folder into the Hierarchy tab. The next step is to drag and drop 

your FBX iClone model into the Assets folder and finally into 

the scene. For teleportation navigation, drag the VRTK Basic 

Teleport script from the scripts folder onto the Camera Rig.

08 Bring in your 3D characters and animation 
for VR Send the iClone character to 3DXchange, 

then open the timeline and make sure that the Collect Clip and 

Motion timelines are visible. Highlight the entire timeline with 

Collect Clip if it fills the timeline – otherwise you’ll have to select 

only those that are relevant to your needs. With your mouse 

hovering over the Collect Clip timeline highlight, press Ctrl/

right-click with your mouse button on choose Add Motion to 

3DXchange if it’s motion only or select Add MotionPlus to 

3DXchange if you have other animation to be included with the 

motion. From 3DXchange add motions to the Perform track 

and export the FBX.

07
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All tutorial files can be downloaded from: filesilo.co.uk/3dartist
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Get started with Radeon
ProRender for Maya
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M
ost 3D artists are always looking for better, easier 

and faster alternatives to render out 3D scenes, and 

the good thing is that new technology is helping 

developers to create powerful tools for us. Nowadays there 

are so many diff erent types of render engines that we can 

choose from. Recently I was asked to try Radeon ProRender, 

an impressive physically-based render engine. Radeon 

ProRender is a hugely powerful tool, giving you interactive 

workfl ows facilitating the production of photorealistic images. 

I regularly use four diff erent renderers including Arnold, 

mental ray, RenderMan and KeyShot, and now I am including 

a fi fth, Radeon ProRender. Its technology is great because it 

uses both the GPU and CPU to compute your complex 

scenes. Radeon ProRender also uses GI (Global Illumination), 

which is great for accurate light rays.

As 3D artists we all know how important lighting and 

materials are. Even though most renderers use their own 

methods to calculate light and render shaders, at the end of 

the day the purpose is the same. That is why I think learning a 

new render engine is good, as you can always discover some 

features that other renderers lack. Sometimes, when I have 

more complex scenes, I render in diff erent render engines 

and then put them together in post-production. Radeon 

ProRender has a very cool material library with presets that 

are ready to use – I like to make my own shaders but you can 

always use these presets as a starting point. 

The main goal for this tutorial is to go over the basics of 

Radeon ProRender with a fairly simple scene, with a focus on 

materials, lighting and rendering. By the end you should have 

enough information to start playing with Radeon ProRender.

RADEON PRORENDER
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01 Get started with Radeon ProRender By default, 

Maya will not have the plugin loaded. Let’s start by 

loading Radeon ProRender under Maya’s Plug-in Manager. 

After doing so we will have a new shelf tab dedicated to 

Radeon ProRender’s options. Most options are easy to 

understand. You can always hover your mouse over the icons 

and Maya will display a brief explanation of what they do. If you 

click on the last icon on the right it will take you to Radeon 

ProRender’s tutorial website.

 02 Assign materials Let’s assign our fi rst material. 

When you right-click to assign a new material you can 

see four diff erent options. PBR Material will be your overall 

standard material. You can change the settings to achieve 

diff erent looks, like specular or refl ective. To do this you can go 

to Attribute Editor>Swatch Properties>Type. You can also mix 

them up, and in this case you will have to choose the PBR Blend 

Material. This will allow you to mix two or more PBR Materials 

together, so you can mix two PBR materials – a Diff use and 

Refl ective, for example – into the PBR Blend Material.

03 
Access the library One of the main benefi ts of 

Radeon ProRender is its pre-made library shaders, 

such as wood, glass and plastic. You can load the library by 

going to Radeon ProRender’s shelf tab and clicking the XML 

icon. Once you fi nd a good material, double-click it – the 

material will then be added to the hypershade, where you can 

add it to the object. Keep in mind that you can always modify 

these presets to come up with your own personal materials. 

Remember that the presets come with lots of input nodes, and 

if you delete them you will delete the entire material.

04 Set up lighting Most 3D render engines have 

similar workfl ows when it comes to lighting. I like to 

use IBL with all the renderers I use, and Radeon ProRender is no 

exception. IBL, or image-based lighting, is great for realistic 

refl ections and shadows, plus it tends to do most of the lighting 

without adjusting much. To create your own IBL setup, just go 

the shelf tab and click on IBL. Then, in its attributes, you can 

add the HDR of your choice. Keep in mind that the quality of 

your IBL will depend on the resolution of your HDR.

05 Understand lights As for lights, you can use the 

standard Maya lights such as Area, Direction or Point 

light. Sometimes it’s better to adjust the materials rather than 

spend too much time tweaking the lights. Radeon ProRender 

has a quick and easy way to emit light from an object – to do so, 

just click the object then go to the shelf tab and click on the 

Emissive icon. You can also use the Radeon ProRender material 

viewer in the hypershade to see what your materials look like 

with IBL before rendering.

06 Adjust render settings You can open the Radeon 

ProRender render settings either by clicking on the 

Render Settings icon on the shelf or just in the default Maya 

render settings. You can use out-of-the-box render settings or 

quality presets, then you have the option of adjusting your 

settings depending on your scene. I chose the preset ‘High’, but 

you can always opt for more or less. Also, you can adjust the 

settings manually, but keep in mind that the higher the quality, 

the more time it will take to render. One last thing; in the same 

window, under the Environment tab, you can manage your IBL 

and create a Physical Sun if you need to.
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 WORKSTATION SPECIALISTS WS-X1100S

T
hanks to modern PC components and 

clever case design, there are fewer 

compromises, if any, when opting for a 

tiny small-form factor PC case over a 

traditional gigantic tower. A mini-ITX 

motherboard with a high-end CPU and 

memory, along with a full-sized GPU, will fi t 

into a case that can easily be tucked away into 

a corner, along with a PSU that can provide 

enough juice to feed a power-hungry 3D rig.

While nobody has yet managed to squeeze 

a dual-CPU motherboard into such a small 

space, mini-ITX motherboards off er the same 

level of performance as full-sized ATX boards, 

and can support Intel’s top-end Extreme 

Edition chips with up to ten cores, which is a 

solid basis for CPU-based rendering. There’s 

space for plenty of DDR4 memory and a 

professional-grade graphics card, although 

this depends on whether the case has enough 

space to fi t a dual-slot card.

That’s the the thinking behind the 

WS-X1100S from Workstation Specialists, a 

powerful mini-ITX rig intended for high-end 

3D design, without giving up any of the 

performance of a larger system. It has an Intel 

Core i7-6950X – a ten-core Extreme Edition 

chip, with a default clock speed of 3.5 GHz, 

but a nice overclock applied that brings it right 

up to 4.2 GHz, helped by the inclusion of a 

Corsair H100 liquid cooler. 

Measuring just 24-centimetres high and 

33-centimetres deep, you’ll barely notice it’s 

there. 16GB of DDR4 memory came in our 

test system, but this can be upgraded to the 

maximum of 32GB that is possible on the 

ASRock x99e-ITX AC motherboard. Here lies 

the only real restriction of mini-ITX 

motherboards, which could be an Achilles’ 

heel for any such small system for 3D use, 

when the most detailed environments can 

require even more than this.

Last, a 256GB Samsung SM951 M.2 SSD is 

included for the system drive and a 2TB hard 

disk for extra storage.

We questioned whether the inclusion of 

the £5,000+ NVIDIA Quadro P6000 

graphics card was right for this system, given 

its price tag overshadows the rest of the 

components combined. It’s the most 

expensive and powerful professional card on 

the market, with 24GB of GDDR5X graphics 

memory, 3,840 cores and the new Pascal 

architecture that we saw such a fantastic 

performance improvement from with the 

GeForce GTX 1080. But of course, the 

confi guration is entirely customisable, so you 

can choose something less expensive, 

including less high-end Quadros, such as the 

P5000 and M4000, one of AMD’s FirePro 

cards or a GeForce GTX 1080. Use a cheaper 

card and the system is far more aff ordable.

It’s worth pointing out that despite its 

diminutive dimensions, the Lian Li case can 

easily fi t a dual-slot card, not to mention 

we’ve fi nally had a chance to play with such a 

nice GPU, as this is the fi rst time we’ve had a 

chance to really test the Quadro P6000. 

There are also larger hard disks up to 8TB, 

512GB SSD options and a number of extra 

peripherals are available on the website.

It’s mind-boggling to see how all this 

hardware fi ts into such a small space. It’s a 

tight fi t with any fully loaded mini-ITX system, 

and there’s not much room for anything else 

inside the WS-X1100S. But temperatures 

remain under control at 28°C when idle, 

climbing to a manageable average of around 

65°C during rendering.

It can get a little noisy. Workstation 

Specialists quotes 46dB on its site, and this is 

roughly accurate. During a render, the fans do 

indeed become noticeably audible, but we 

stress it’s not a major issue and is no noisier 

than most full tower systems.

In performance tests, though, we’re back to 

seeing why this system is so impressive. It not 

only matches most workstations, but beats 

them too. CPU performance gives results that 

put larger systems to shame, achieving 2213 

points in Cinebench and completing the new 

1080p underwater test in 3ds Max 2017 in 

two minutes. Great stuff . The NVIDIA Quadro 

P6000 dominates SPECViewPerf as well, 

with the best results we’ve ever recorded and 

over 207 points in the Cinebench 3D test.

So the last question is, should you buy it? 

With enough performance to beat the big 

boys, and with rendering performance not an 

issue, it’s a matter of personal preference over 

whether you want a small system. If you’re 

unfortunate enough to work out of a tiny 

offi  ce, you might have a real need for the 

petite WS-X1100S, and given how fast it goes, 

there’s not much else to match it.

Orestis Bastounis

The smallest 3D system we’ve seen squeezes a ten-core CPU 
and powerful NVIDIA Quadro P6000 into a mini-ITX chassis

Workstation Specialists 
WS-X1100S
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MAIN The WS-X1100S packs a high-end rendering 
specifi cation into a tiny case

BOTTOM LEFT Squeezing water cooling into a mini-ITX case 
can be challenging, but Workstation Specialists has pulled it off  
with the Corsair H100

BOTTOM RIGHT You might fi nd it hard to add a second hard 
disk, so we recommend splashing out for the 8TB option

BELOW This machine boasts the brand new NVIDIA Quadro 
P6000 professional graphics card

LEFT A smaller machine doesn’t necessarily mean a 
compromise in rendering power

Verdict

Summary

With the rendering ability of a full-sized tower, the 

WS-X1100S will be great for 3D design in any studio

Price   £7,295.60 (excl VAT)

Website  workstationspecialist.com

CPU  Intel Core i7-6950X (clocked to 4.2 GHz)

RAM  16GB DDR4 memory

GPU  NVIDIA Quadro P6000

SSD  256GB Samsung SM951 PCI-Express

HDD  3TB

Essential info

Features

Performance

Design

Value for money

 With enough performance 
to beat the big boys, and with 
rendering performance not 
an issue, it’s a matter of
personal preference  
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 ANIMA 2

Verdict
Very easy to use and good value, there’s also plenty of

room for Anima to expand

Price €249

Website secure.axyz-design.com/anima-crowd-

simulation-software-home

OS MicrosoftWindows7,Windows8.1, or

Windows 1064-bit

CPU IntelCore i5 /AMDFXorbetter

RAM 4GB(8GB recommended)

HDD 10GBof free space

GPU DirectX 10orOpenGLcapable (1GBor

higherVRAM)

Internet One-timeconnection required for activation

Essentialinfo

Summary
Features

Performance

Design

Value for money

Anima 2

A
XYZ design has released a new version of 

its standalone crowd animation software 

for visualisation professionals. The first 

thing you’ll notice is a brand-new UI that enhances 

ease of use and discoverability of features with a 

new WYSISYG editor. There are two UI modes to 

switch between: Drawing, which is for scene 

populating, and Editing, which is for customising 

actors. Before populating a scene you’ll first need 

to import an environment. To 

help minimise performance 

issues, it’s good practice to only 

import what’s essential and use 

low-poly proxy geo where 

characters will interact with the 

background and props.  

For crowd setup, the Walkway 

tool is used to plot waypoints on 

terrain and then customise the 

walkway as desired. Alternatively, 

Objects and Actors can be dragged and dropped 

in from the Library. Anima gives full support for 

ramps, bridges and irregular terrain, plus there are 

tools for controlling Actors to avoid obstacles, look 

at chosen areas, control street crossings with 

traffic lights and more. But there’s plenty of room 

for expansion to the range of Library assets, and 

add-on packs would be a welcome future 

enhancement. Library Objects and Walkway 

parameters are adjusted with sliders in the 

Properties panel, which is clearly organised and 

provides a suitable range of settings to adjust. 

Once done, the Actors are exported into your 

high-res scene for rendering. 

Bundled content includes a fairly limited library 

of photoreal actors and mocap files, which are 

more than adequate for a range of projects but will 

inevitably become overused. Third-party actors 

and mocap can be added to the library with 

support for industry-standard formats including 

OBJ and FBX to expand the 

collection. Compatible actors can 

also be purchased from 

Metropoly, AXYZ’s online library 

of characters and mocap stock 

assets. The character specification 

and import process is not overly 

daunting, and opens the door to 

other asset genres such as 

creatures and robots. The 

upgraded Pose editor lets you 

work directly with a rig to fix minor issues, such as 

intersections from applying mocap data to actors 

or creating a different pose, and thankfully negates 

a to-and-fro workflow with your 3D app. 

Windows only, Anima 2 is compatible via plugins 

with 3ds Max 2011 and Cinema 4D R14 and higher, 

and supports their built-in renderers plus Octane, 

Corona, Thea, V-Ray, ART, Iray and mental ray. It 

comes with three render nodes and several online 

renderfarms support it too.

Paul Champion

The crowd production suite previously known as an(i)ma has been fully rewritten from the ground up

TOP With Anima 2 you can command actors to walk, run, sit, 
navigate slopes, talk, ride escalators, cheer, traverse moving 
walkways, climb stairs and more

 Bundled 
content includes 
a limited library 

of photoreal
actors and

mocap files  
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BFX Festival director
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students at this year’s 

competition have been ashigh
as ever and it is great to see
them working together  



S
eeing what you sculpt on a computer monitor is the 

standard nowadays, but what if you wanted to go 

above and beyond using the typical software? Better 

yet, what if you wanted to learn how to create art right in 

front of your eyes, in virtual reality, and get top techniques 

and tips from some of the best minds in the videogames, 

film and VR industries?

That’s what sculpting app Oculus Medium is hoping to 

inspire artists to do in VR with its new Facebook Live 

sculpting events. Every month, a different artist is featured 

in a live Artist Spotlight video on the Oculus Medium 

Facebook page. 

The broadcast features the artist 

creating a model from scratch with 

Medium and using the Oculus Touch 

controllers, showing viewers how to 

work with Medium to sculpt, paint 

and design different types of projects 

and in different art styles. Any 

comments and questions that are 

submitted live are also answered by 

the artist there and then. The live 

event is hosted by Oculus Medium 

Triple-Aartists teach live inVR
Monthly Facebook Live events showcase a roster of the top artists working with virtual reality

engineer and director Brian Sharpe, who also provides some 

behind-the-scenes details on how some of the tools in 

Medium came to be.

 “The Oculus Medium Facebook Live events are designed 

to share the Medium process for individual artists so people 

can see the different possibilities,” says Andrea Ragni 

Schubert, communications manager at Oculus, on the idea 

behind the live shows. “Each artist approaches the creation 

process slightly differently, so we wanted to show how that 

unfolds live. During the events, we also allow people to ask 

questions while the artist is working to provide an 

educational element that wouldn’t be 

possible with a non-interactive form of 

media, like video.” 

Art director Goro Fujita, who won 

an Emmy for his work on VR 

experience Henry, kicked off the first 

event in September with a robot 

model. In the live event, Fujita had 

prepared custom brushes. “I prefer to 

do them inside Medium, because you 

just make them,” he explained to an 

inquisitive viewer. “You can also model 

 COMMUNITY NEWS
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Each artist 
approaches the creation 

process slightly 
differently, so we wanted 

to show how that 
unfolds live

Andrea Ragni Schubert,  
communications 

manager at Oculus

Landis Fields 
demonstrated some 
of the different tabs 

and tools available 
for building a 

spaceship in Medium 
in the live video
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BFX attractsOscarwinners
The festival won big in 2016 with its star-studded line-up

BFX 2016 returned to the Bournemouth

International Centre this year and was a

huge success. There were standout

presentations from Double Negative’s

Mark Ardington, who discussed rigging

techniques in Ex Machina and brought his

Academy Award to Bournemouth, Pixar’s

Steve LaVietes on the new rendering tech

implemented in Finding Dory, and from

ILM’s Mike Mulholland and Kevin Jenkins

on the digital effects built for Star Wars:

The Force Awakens.

The BFX Careers Hub on 14 October

was packed with prospective students

and plenty of computing and sculpting-

related activities adorned the schedule for

the BFX Family Weekend.

The winners of the BFX Competition

2016 were also revealed at the Awards

Ceremony. Competing teams of visual

effects and animation students worked

for seven weeks to create a short

advertisement for charity. Alpaca Chinos

won for Refuge, the domestic abuse

support charity, and Team Pablo won for

Create, the creative arts charity.

Sofronis Efstathiou, BFX Festival

director, said, “The standard of the

students at this year’s competition has

been as high as ever and it is great to see

them working together and putting their

creativity and their skills to the test to

create some really great films this year.

While it is sad that this year’s competition

has come to an end, we can now look

forward to what the BFX Competition in

2017 has to bring.” Congratulations to all

of the winners!

brushes, objects and traditional sculpting tools and bring 

them in as OBJ files no problem.”

The Facebook Live event was followed with a second a 

month later and this time featured Landis Fields, artist at 

Industrial Light & Magic’s xLAB, who has just wrapped up 

work on Doctor Strange. Fields created a spaceship in the 

hour-long live video.

Oculus character artist Giovanni Napkil explained why 

modelling in VR is so useful to a diverse range of artists 

including Fields and Fujita. “Say, for example, we’re trying to 

figure out a scene in VR, we can build it then and there, lay it 

out as if you’re like an interior designer, pushing and pulling 

things around. 

“Working in film, characters are always bound by the 

frames of a 2D screen. As realistic as the character is, you 

never really get the feeling of it being there. With VR, there’s 

a lot more to consider in terms of selling the believability of 

the character. So a lot of the sculptural philosophies that I 

always carry, like believing in clean form and structure, 

matter more in VR as you’re seeing the character in the 

rounds as if it’s with you in the room.”

Oculus Medium comes with the purchase of the Oculus 

Touch controllers. Keep up to date with future Oculus 

Medium Artist Spotlight live events by liking the page on 

Facebook: facebook.com/oculusmedium.

Goro Fujita created custom stamps in Medium during the first half of his
Facebook Live video that he returned to later on
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Since March 2015, Epic Games has given no strings 

attached financial assistance to any projects built 

with Unreal Engine 4 via Unreal Dev Grants. The 

grants have now racked up an incredible $1.8 million 

worth of aid out of the total allotted $5 million.

Chance Ivey, Epic Games’ senior community 

manager, explains the idea behind the Grants and 

how they will help developers: “Our vision for 

Unreal Dev Grants has always been to help remove 

obstacles that developers face and to reward their 

phenomenal work built in or for Unreal Engine 4. A 

core part of the philosophy behind Unreal Engine is 

developer success and empowering others to reach 

their potential. These values appear in our licensing 

model, our resource offerings and programs we 

support. We succeed when you succeed. Making 

games is especially difficult and comes with a 

unique and diverse set of challenges. We launched 

the no-strings initiative to aid teams and individuals 

alike in tackling these challenges head on. Unreal 

Dev Grant assistance can give a team the bump 

that’s needed, for example, to hire [quality analysts] 

or to make a great trailer.”

The awards have ranged from $5,000 to over 

$100,000 at a time to team-based and solo 

projects including the work of instructors, 

developers, programmers, artists, designers and 

much more. To submit an application and to be in 

with a chance of receiving Epic Games’ Grants, 

apply at www.unrealengine.com/unrealdevgrants.

HAVE YOU HEARD? Popular game engine Unity is going to get Otoy’s OctaneRender built in for free from 2017 

Epic Games gives
out $1.8 million
Money was presented as part of Unreal Dev Grants

How to spend $15,000
One of the early recipients of the Unreal Dev 

Grants was Michael Blackney, who was 

given $15,000 for Dead Static Drive. “I’ve 

been to GDC once since then (which is 

around $4,000 AUD for accommodation, 

flights, and the convention pass), I’ve 

licensed a lot of audio, and I’m working with 

a musician now on an original soundtrack.”

Substance 
Source’s free 
asset library

Get Substance Source as part of Substance 
Live or from a one-time purchase

Autumn has been a busy season for

Allegorithmic, as the texture software 

developer released both Substance 

Painter 2.4 and a new materials library. 

Substance Source will be freely 

available to all Substance Live 

subscribers, or for a one-time purchase 

for 12 months of access.

The library will be full of physically 

based scanned, procedural and 

hand-painted materials that will be  

added to over time. As part of the 

launch, Allegorithmic commissioned 

artists to produce special assets. 

Sketchfab’s visualisation technology 

will also be implemented into 

Substance Source so that users can 

view materials from any angle.

Substance Source can be eventually 

accessed via the Substance suite of 

tools, so that downloads can be done 

inside the shelves.

In addition to this, Allegorithmic has 

announced that users of Substance 

Indie Packs that were purchased after 

16 March 2016 will receive 180 free 

downloads, and Substance Designer 5 

Indie or Substance Painter 2 Indie or 

Substance B2M 3 Indie users will 

receive 60 free downloads (which will 

be valid forever).

Allegorithmic launches 
procedural and hand 
painted materials 

Michael Blackney has wanted to make a 
horror game set on Route 66 since his days 
working in larger games studios
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 DID YOU KNOW? Amazon Lumberyard is opening up a new studio in Austin, Texas – just down the road from the Twitch offi  ces

Bringing you the lowdown on product updates and launchesSoftware shorts
Rig On Demand
The new auto-rigging tool for Maya 

from EISKO can turn a rigid 

character into a rigged facial 

animation with 120 expressions. This includes 

muscle deformations adapted to the model’s 

topology with control over all the separately 

provided geometries. You can also adjust 

blendshape nodes, map controllers or bones.

UVLayout 2.10 
Version 2.10 brings an Import button 

for loading other meshes into the 

scene to enable copying of UVs 

between meshes or for packing combined shells 

into a single map. Existing tools like Display and 

Pack have been changed, with the latter getting an 

option for zero-degree rotation with random shell 

shuffl  ing among others.

Miarmy 5.0 
The free crowd simulator’s version 5 

release is available now, with a focus 

on automation (thanks to a new 

automation engine) and user experience. 

Automated features include terrain, collision 

avoidance, follow road and reverse road. 

There are also huge improvements to the bone 

and rig standard.

New version gets instant 
feedback, multiple scattering, 
ozone simulation and more
Planetside’s scene rendering software has just 

gotten incredibly more photorealistic and more 

effi  cient for artists. A Ray-Traced Preview feature 

enables instant feedback for tweaking objects, 

lighting, shaders and so on. On the offi  cial 

release page, Planetside calls Terragen 4’s 

Multiple Scattering in clouds a “major 

breakthrough” that has taken years of 

development. The result is the simulation of light 

scattering hundreds of times to produce 

softness, inter-cloud and cloud-surface 

interactions. There is also now simulation of the 

absorption of light in the ozone, animation 

controls for adding motion blur, lens eff ects 

taking into account light sources, specular 

refl ection intensity and much more.

Makes 3D easier to use for 2D artists 
unaccustomed to 3D techniques
Project Felix is a new tool from Adobe that enables the 

compositing of 3D models and assets onto a 2D image. 

Project Felix will also allow the adjustment of lights, 

materials and perspective for “state-of-the-art 

photorealistic rendering”. Richard Curtis, principal 

solutions consultant at Adobe, said: “There are two 

things that we are hearing from our customers. First is 

that they would like to use 3D objects and scenes to 

complete their tasks, without having to learn complex 

3D tools… Second is that they are under pressure to 

deliver more content than ever before and need tools 

that are fast [and] intuitive… Felix was born from a 

combination of these needs, as well as modern intuitive 

experience, allowing a 2D designers without any 3D 

skills to make use of 3D objects, lights, materials and 

photographic backgrounds.”

Having been in open beta since 
October, version 3 is out now with 
plenty of new features
After a month of open beta, Marmoset Toolbag 

3 has been released. Support for animation 

rendering has been added, going above and 

beyond previous capabilities of rendered 

turntables and stills. Real-time global illumination 

has been implemented, too, with a new Local 

Refl ections eff ect and a new skin shader. Texture 

baking is integrated into Marmoset Toolbag 3 

with the ability to export tangent space normals, 

object space normals, AO and more. Finally, 

Marmoset Toolbag 3 has a new Scene Bundle 

export feature, and can now export directly to 

Unity, Unreal Engine or even to ArtStation.

Animation in 
Marmoset

Terragen 4’s cloud breakthrough

Adobe goes 3D 
with new tool

Adobe Stock 
will provide 

three diff erent 
asset types for 

Project Felix

j y p
up to twice as fast. Image credit: Jeff  Boser
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Website atomiccartoons.com

LocationCanada/Australia

ProjectBeat Bugs

Project description Beat Bugs is
an animated comedy series
aimed at children, broadcast in
Australia on Channel 7TWO
and on Netflix worldwide

StudioAtomic Cartoons

CompanybioAtomic Cartoons
is a leading full-service
animation company, creating
2D and 3D shows,
commercials, music videos and
much more in the heart of
the animation hub of
Vancouver, Canada.

ContributorRachit Singh, head
of technology

 PROJECT FOCUS

Rachit Singh explains how Qube! 
and Python helped with the work 
needed for the Netfl ix show

Beat Bugs

F
or a series that has been in production for one and a half 

years, Beat Bugs has been a catalyst for tremendous 

change at Atomic Cartoons. 

The Netfl ix show – based on the premise of all-singing, 

all-dancing bugs and featuring popular songs by The Beatles 

– had some tight deadlines, which is no surprise when you 

consider that the entire show was created as one and then 

later on was split into two seasons that debuted merely 

months apart from one another. 

It was up to Rachit Singh, head of technology, to solve the 

problem of speed, alongside a team of pipeline TDs and 

supervisors who needed 100,000 frames rendered. “The 

Beat Bugs schedule was defi nitely pretty aggressive in terms 

of time constraints, just because they needed to get all the 

seasons done by a specifi c date,” he explains. “So we pretty 

much had to work across all the departments and the whole 

pipeline just to make sure we could hit those deadlines.”

With huge amounts of data moving through the pipeline 

across departments, effi  ciency and the use of Python in 

automating processes proved to be a huge winner.

“Pretty much every time [it was] down to how much we 

could actually automate so that we could take people out of 

the equation,” explains Singh. “They don’t have to worry 

about what they need to do and instead focus on how they 

make the art.”

That wasn’t all, though – during work on Beat Bugs, Singh 

found a roadblock in Atomic’s renderer. “Mental ray is not a 

very effi  cient renderer, so to get around some stuff  we had to 

crank up some settings.” Singh mentions that this was due to 

render artifacts appearing, but luckily render farm manager 

Qube! came to the rescue. “Qube! is a very laidback render 

manager,” Singh explains. “It doesn’t do a lot; you can actually 

confi gure it to do whatever you want it to do.

“I fi nd it very fl exible to use. I can set up diff erent job types 

– I can set up my own job types. It has lots of management 

that you can do centrally for logs and confi gs, which is very 

handy when you’re managing 500 nodes on the farm. If you 

want to push a confi g, it’s very easy to push that confi g down 

all those workers.” 

Though it was defi nitely hard work, Singh speaks highly of 

the project and how constructive the process was in the end 

for the studio: “We learned a lot as well, so we now have so 

many things changing going forward on new shows. It was a 

valuable experience for sure.”

Singh also reveals that Atomic Cartoons will be moving 

over to using RenderMan more in the future. “RenderMan on 

[our] new show is very exciting. I think everybody in the 

studio is excited about it.

“Also we will be adding a lot of cold and new tech for 

managing our assets and leveraging Shotgun more for the 

asset management part of our pipeline. We are also rewriting 

our caching solution, just to help with animation and caching 

animation. That will help in getting the caches properly down 

the pipe.” With so many plans, the future’s looking bright for 

Atomic Cartoons.

“When you are in production it’s very hard to develop

production software while the production is going on,” 

begins Singh. “We decided that Shotgun is a good 

production tracking system and industry-standard 

software as well. We decided to go with it and that cut 

down on development time for the production tracking 

system. We actually want to control that and so that’s 

why we decided to do our own asset management, and 

it keeps us fl exible too. In the future if we don’t want to 

use another production tracking software, we can just 

hook up our asset manager to Shotgun and then we 

don’t have to be totally dependant on that.”

02

PROPRIETARY VERSUS 
OFF THE SHELF
Discover why Atomic Cartoons’ asset 
manager is proprietary and how it 
works with Autodesk Shotgun

01
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01  Atomic Cartoons used Maya for modelling, lighting, 
eff ects and animation for Beat Bugs 

02  “The features we used in Qube! we didn’t fi nd in 
other software, so we kept going back,” says Singh

 
03  Working across all the shows in the studio, Singh 

states, “It was a step up from the last show we did” 

04   “We try to keep our tools as similar as possible for 
2D and 3D,” says Singh of the diff erent show types

05  The post-production team would work on making 
the changes necessary for the Beat Bugs broadcast

Rachit Singh,
AtomicCartoons

 We pretty much had 
to work across all the 
departments and the 

whole pipeline just to make 
sure we could hit

those deadlines  

05

03

04



Images of
the month
These are the 3D projects
that have been awarded
‘Image of the week’ on
3DArtistOnline.com in the
last month

03Broken Statue
byBlakeMead
3DA username
blakeovitch
Blake Mead says: “This

project was a simple scene that
came about as a result of
experimentingwith new rendering
methods inmy spare time.”
We say:This scene looks like it could
easily be amysterious opening shot to
amovie. Blake has done a great job at
amodelling and texturing level,
creating something that looks ancient
and forgotten.

04 Pencils
byMarwanSaliba
3DA username
Marwan
Marwan Saliba says:

“Wanting to try FStorm, I created
this pencils scene. I had to render
ZDepth, AmbientOcclusion and
WireColor passes in separate files
– same for the dust particles.
However, somewere added later
in Photoshop.”
We say: Look at all of those colours!
We fell in lovewith this still life render
straight away and think the
imperfections in thewooden elements
and the camera effects – specifically
DOF – are excellent. Nicework.

02Red
byRakanAtef
Khamash
3DA username
RakanKhamash

Rakan Atef Khamash says:
“Red is a little cutemonster that I
based on a 2D concept byCreature
Box. I loved themix of hard and soft
elements. It was sculpted in ZBrush
and rendered inMODO,with post
done in Photoshop and some colour
adjustments in After Effects.”
We say:This awesome concept has
been expertly re-imagined by Rakan
here, andwe can see that a huge
amount ofwork has gone into getting
the high-poly base sculpt just right.

01Mantis Anti-Air
Platform
byTomiVäisänen
3DA username
TomiVäisänen

Tomi Väisänen says: “With this
work, I tried a lot of newmodelling
techniques and tried to improvemy
overall workflow. I also developed
my procedural shaders a bit further.
Most of the textures are procedural
and objects aremostly boxmapped.
Imodelled in 3dsMax and rendered
with Corona, with post and
compositing done in Photoshop.”
We say:This is an incredible example
of Tomi’s hard-surface prowess and a
cool overall design aswell.
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Battle by Agata Cichosz
3DA username muezza
Agata Cichosz says: “This image is part of a larger project, aimed 
at creating scenes of battles and sieges. While working on this I 
learned Golaem Crowd as well as Maya from scratch, which, 

while fun, gave me headaches.”
We say: Props to Agata for having the dedication to sit down and learn Maya and 
Golaem from scratch. Crowds can be really fun to experiment with.

Pizza Build by Amine Bouafi f
3DA username redWill
Amine Bouafif says: “Material proposal for a game, with the 
process of a pizza oven level up. Here you can see the progress 
of a small oven to a more sophisticated one.”

We say: This is a really cool model that expertly combines a low-poly cartoon 
style with a high-poly, detailed feel. Also of note is the simple, but eff ective lighting 
setup and the choice of colours and materials.

Traveler by Artur Gizzatullin
3DA username Artur
Artur Gizzatullin says: “This character is just an improvisation – it 
was invented on the fl y. The result was this, which is bright and 
amusing in my eyes. I used 3ds Max, Corona and After Eff ects.”

We say: We always love interesting creature concepts like this one, as people like 
Artur always manage to come up with something that makes us smile. The 
fl oating eyeballs are a particular stylistic highlight.
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